
사용자 설명서

• 본 제품의 성능을 충분히 이해한 상태에서 안전한 사용을 위하여 본 사용설명서를 반드시 숙지하여
주시기 바랍니다.
• 이 설명서는 필요할 때 참조할 수 있는 안전한 장소에 보관하십시오.
• 명시적인 서면 동의 없이 이 설명서의 전체 또는 일부를 복제, 인용 또는 번역하는 것을 금지합니
다.
• 이 문서의 내용과 이 제품의 사양은 예고 없이 변경될 수 있습니다.
• DGSHAPE Corp.은 본 제품의 일부에 기능 결함이 발생하는 것과 상관없이, 본 제품을 사용함으로
써 직간접적으로 발생하는 모든 손해에 대해 책임을 지지 않습니다.  손해는 제품의 사양이나성능으로
인한 손해, 제품 미사용으로 인한 손해, 본 제품을 사용하여 얻은 결과물로 인한 손해를포함하나 이에
국한되지 않습니다.  그러한 손해는 직접적이거나 간접적일 수 있습니다.
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CAN ICES-3 (A)/NMB-3(A)

For Canada

WARNING:
This product can expose you to chemicals including 
lead, which is known to the State of California to cause 
cancer and birth defects or other reproductive harm. For 
more information go to www.P65Warnings.ca.gov.

For California

Manufacturer:
Roland DG Corporation
1-6-4 Shinmiyakoda, Kita-ku, Hamamatsu-shi, Shizuoka-ken, 431-2103 JAPAN

The importer in the EU:
Roland DG Europe Holdings B.V.
Prof. J.H. Bavincklaan 2, 1183 AT, Amstelveen, The Netherlands

For EU Countries

DGSHAPE Corporation has licensed the MMP technology from the TPL Group.

This system (including the housing and safety device) is a Class 1 laser product.

Complies with IEC 60825-1 Edition 2.0 (2007-03).
Complies with FDA performance standards for laser products except for deviations pursuant to Laser notice 
No.50 dated June 24, 2007.

Caution - Use of controls or adjustments or performance of procedures other than those specified herein may 
result in radiation exposure.

[Laser specifications of this system] (including the housing)
Max. output: 46.5 µW, Pulse duration: 3.0 µs, Wavelength: 655 nm

FEDERAL COMMUNICATIONS COMMIS-
SION RADIO FREQUENCY INTERFERENCE 

STATEMENT

NOTE:
This equipment has been tested and found to comply with 
the limits for a Class A digital device, pursuant to part 15 
of the FCC Rules.
These limits are designed to provide reasonable protec-
tion against harmful interference when the equipment is 
operated in a commercial environment. This equipment 
generates, uses, and can radiate radio frequency energy 
and, if not installed and used in accordance with the in-
struction manual, may cause harmful interference to radio 
communications. 
Operation of this equipment in a residential area is likely 
to cause harmful interference in which case the user will 
be required to correct the interference at his own expense.

Unauthorized changes or modification to this system can 
void the users authority to operate this equipment.

Use only I/O cables that have been designed and manufac-
tured specifically for this device.

For the USA

WARNING
This is a Class A product. In a domestic environment this 
product may cause radio interference in which case the 
user may be required to take adequate measures.

For EU Countries

Manufacturer:
Roland DG Corporation
1-6-4 Shinmiyakoda, Kita-ku, Hamamatsu-shi, Shizuoka-ken, 431-2103 JAPAN

The importer in the UK:
Roland DG (U.K.) Ltd.
Griffin House, Windmill Road, Clevedon Business Park, Clevedon, North Somerset, BS21 6UJ, 
United Kingdom

For UK



For China

For EU Countries

产品中有毒有害物质或元素的名称及含量 

部件名称 

有毒有害物质或元素 

铅(Pb) 汞(Hg) 镉(Cd) 
六价铬 

(Cr(Ⅵ)) 

多溴联苯 

(PBB) 

多溴二苯醚 

(PBDE) 

印刷电路板 × ○ ○ ○ ○ ○ 

头部 × ○ ○ ○ ○ ○ 

壳体、底架 × ○ ○ ○ ○ ○ 

电源 × ○ ○ ○ ○ ○ 

其他（电缆、附件等） × ○ ○ ○ ○ ○ 

 ○：表示该有毒有害物质在该部件所有均质材料中的含量均在 GB/T26572-2011 标准规定的限量要求以下。 

 ×：表示该有毒有害物质至少在该部件的某一均质材料中的含量超出 GB/T26572-2011 标准规定的限量要求。

环保使用期限 

此标志适用于在中国国内销售的电子信息产品，表示环保使用期限的年数。 

所谓环保使用期限是指在自制造日起的规定期限内，产品中所含的有害物质 

不致引起环境污染，不会对人身、财产造成严重的不良影响。 

环保使用期限仅在遵照产品使用说明书，正确使用产品的条件下才有效。 

不当的使用，将会导致有害物质泄漏的危险。 

This product must be disposed of 
separately at your local waste recycling 
center. Do not dispose of in household 
waste bin. 

Bitte führen Sie dieses Produkt separat 
Ihrer örtlichen Entsorgungsstelle zu. 
Bitte nicht mit dem normalen Hausmüll 
entsorgen.

Ne jetez pas le produit avec vos 
ordures ménagères. Portez-le dans un 
centre recyclage des déchets.

Questo prodotto deve essere smaltito 
negli appositi contenitori per la raccolta 
differenziata, non buttare nel cestino 
dei rifiuti casalinghi.

Este producto debe devolverse al 
centro de reciclaje más cercano a su 
domicilio para su correcta eliminación. 
No lo tire a la basura.

Deite fora separadamente este produto 
no seu centro de reciclagem local. Não 
o deite fora no seu caixote do lixo.

Lever dit product in bij een lokaal 
afvalverzamelpunt. NIET met normaal 
huishoudelijk afval afvoeren.

Dette Produkt skal smides særskilt 
væk på den lokale affalds- og 
genbrugsstation. Må ikke smides ud 
sammen med almindeligt 
husholdningsaffald.
Tätä tuotetta ei saa hävittää 
normaalien talousjätteiden mukana, 
vaan se on toimitettava 
ongelmajätteiden keräilypisteeseen 
hävitettäväksi.

Produkten måste kasseras separat på 
din lokala återvinningscentral. Släng 
inte produkten tillsammans med 
hushållssoporna.

Μην πετάξετε το αντικείμενο αυτό στο 
καλάθι των απορριμμάτων. Αφαιρέστε 
τις μπαταρίες και προσκομίστε το στο 
τοπικό κέντρο ανακύκλωσης.
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안전한 사용을 위해

기기를 부적절하게 취급하거나 조작하면 부상을 입거나 재산상의 손해를 입을 수 있습니다.  이러한 
부상이나 손상을 방지하기 위해 준수해야 할 사항은 다음과 같습니다.

 경고 및    주의 사항에 대하여

 경고
기기를 부적절하게 사용할 경우 사망 또는 중상 위험을 사용자에게 경고하기 
위한 지침에 사용됩니다.

 주의

기기를 부적절하게 사용할 경우 부상 또는 물질적 손상의 위험을 사용자에게 
경고하기 위한 지침에 사용됩니다.
*물적 피해란 공간과 공간에 있는 모든 가구, 가축 또는 애완동물에 대해 발
생하는 피해 또는 기타 악영향을 의미합니다.

심볼에 대하여
    기호는 사용자에게 중요한 지침이나 경고를 알려줍니다.

기호의 특정 의미는      기호내에 포함된 디자인에 의해 결정됩니다.

왼쪽의 예시 기호는 "감전 위험"을 의미합니다. 

    기호는 절대 수행해서는 안되는(금지) 항목을 사용자에게 경고합니다.

기호의 특정 의미는      기호내에 포함된 디자인에 의해 결정됩니다.

왼쪽의 예시 기호는 "장치를 분해해서는 안됩니다"를 의미합니다. 

    기호는 수행해야하는 사항을 사용자에게 경고합니다.
기호의 특정 의미는     기호내에 포함된 디자인에 의해 결정됩니다.
왼쪽의 예시 기호는 "전원 코드 플러그를 콘센트에서 뽑아야합니다."를 의미
합니다. 
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안 전 한  사 용 을  위 해

잘못 조작하면 부상을 입을 수 있습니다.

 경고
부품 및 옵션 부품을 부착하거나 제거 할 때
와 기기를 전원에 연결할 필요가없는 유지 
관리를 수행 할 때는 항상 전원 코드를 뽑으
십시오.

기기가 전원에 연결된 상태에서 이러한 작
업을 시도하면 부상을 입거나 감전 될 수 있
습니다.

기기에서 아이들을 멀리하십시오. 

기기는 어린이에게 위험을 초래하고 부상, 
실명, 질식 또는 기타 심각한 사고를 초래할 
수 있는 구성 요소가 있습니다.

기기를 분해, 수리 또는 개조하지 마십시
오.

화재, 감전 또는 부상을 입을 수 있습니다.  
숙련 된 서비스 기술자에게 수리를 맡기십
시오.

피곤한 상태 나 술이나 약물을 섭취 한 후에
는 절대로 기기를 작동하지 마십시오. 

작동 시에는 정확한 판단이 필요합니다.  판
단력이 약한 상태로 기기를 작동하면 사고
가 발생할 수 있습니다.

기기에 올라가거나 기대지 마십시오. 

기기는 사람을 지원하도록 만들어지지 않
았습니다.  기기에 올라가거나 기대면 구성
품이 분리되어 기기에서 떨어질 수 있습니
다.

절삭 공구 주변을 주의하십시오. 

절삭 공구는 날카 롭습니다.  파손 된 절삭 
공구도 위험합니다.  부상을 방지하려면 항
상 주의하십시오.

무뎌진 절삭 공구는 사용하지 마십시오.  기기
를 양호한 작동 상태로 유지하려면 적절한 시
기에 수행하는 유지 보수가 필수 입니다.

부적절하게 사용하면 화재나 부상을 입을 수 
있습니다.

커버에 금이 가거나 파손 된 경우 기기를 
작동하지 마십시오.

부상을 입을 수 있습니다.  커버가 갈라 지
거나 파손 된 경우 공인 Roland DG Corp. 
대리점에 문의하십시오.

사용 설명서에 설명 된 작동 절차를 따르십
시오.  기기의 사용법이나 취급에 익숙하
지 않은 사람은 절대로 만지지 마십시오.

잘못된 사용이나 취급은 사고로 이어질 수 
있습니다.

깨끗하고 밝은 곳에서 작업을 수행하십시
오.

어둡거나 어수선한 장소에서 작업하면 실수
로 넘어져서 기기에 걸리는 등 사고가 발생 
할 수 있습니다.

기기를 분해, 수리 또는 개조하지 마십시
오.

화재, 감전 또는 부상을 입을 수 있습니다.  
숙련 된 서비스 기술자에게 수리를 맡기십
시오.
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안 전 한  사 용 을  위 해

경고

이 기기의 정격(전압, 주파수 및 전류)을 
준수하는 전기 콘센트에 연결하십시오.
잘못된 전압이나 불충분한 전류가 화재나 
감전의 원인이 됩니다.

등급 라벨

감전 또는 화재의 위험

전원 플러그가 항상 즉시 닿을 수 있는 위치
에 두십시오.
비상시 전원 플러그를 빠르게 뽑을 수 있
도록 하기 위함입니다.  전기 콘센트 옆에 
기기를 설치하십시오.  또 전기 콘센트에 
즉시 접근할 수 있도록 충분한 빈 공간을 
확보합니다.

전용 AC 어댑터 이외의 전원을 사용하지 
마십시오.
다른 전원 공급 장치와 함께 사용하면 화
재나 감전의 원인이 될 수 있습니다.

전원 코드, 플러그 및 전기 콘센트를 올바르
고 조심스럽게 다루십시오.  손상된 물품은 
절대 사용하지 마십시오.
파손된 물품을 사용하면 화재나 감전의 위
험이 있습니다.

멀티탭을 사용할 때는 기기의 정격(전압, 
주파수, 전류)에 맞는 것을 사용합니다.
하나의 콘센트에 여러 개의 전기 장치를 
사용하거나 긴 연장 코드를 사용하면 화재
가 발생할 수 있습니다.

끼임, 걸림, 화상 위험

경고

밀링 공구와 소재를 단단히 고정합니다.  
고정한 후에는 스패너나 기타 물품이 실수
로 기기 내부에 남아 있지 않은지 확인하
십시오. 
그렇지 않으면 이러한 물품이 기기에서 튕
겨져 나가 기기 손상및 부상의 위험이 있
습니다.

끼이거나 신체 일부가 내주에 걸리지 않도
록 주의하십시오.
특정 부위에 부주의하게 접촉하면 손이나 
손가락이 끼일 수 있습니다.  작업을 수행
할 때 주의하십시오.

스파크, 연기, 타는 냄새, 비정상적인 소음 또
는 비정상적인 작동이 발생하면 즉시 전원 코
드를 뽑으십시오.  부품이 손상된 경우 절대로 
기기를 사용하지 마십시오. 

기기를 계속 사용하면 화재, 감전 또는 부상
을 입을 수 있습니다.  공인 Roland DG 
Corp. 대리점에 문의하십시오.

기기를 실외 또는 물에 노출되거나 습도가 
높은 장소에서 사용하지 마십시오.젖은 손
으로 전원 코드, 플러그 또는 전기 콘센트
를 만지지 마십시오.

화재나 감전이 발생할 수 있습니다.

가연성 물체를 근처에 두지 마십시오.  근처
에서 가연성 에어로졸 스프레이를 사용하지 
마십시오.  가스가 축적 될 수있는 장소에서
는 절대로 기기를 사용하지 마십시오.

연소 또는 폭발이 발생할 수 있습니다.

용도에 맞지않게 기기를 사용하거나 용량
을 초과하는 과도한 방식으로 기기를 사
용하지 마십시오.

부상이나 화재가 발생할 수 있습니다.
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안 전 한  사 용 을  위 해

경고
제공된 전원 코드 및 AC 어댑터를 다른 
제품과 함께 사용하지 마십시오.

내부에 이물질이 들어가지 않도록 하십시오.  
기기를 액체가 엎질러진 곳에 절대 노출시키
지 마십시오.
통풍구에 동전이나 성냥 등의 물건을 넣거
나 음료수를 흘리면 화재나 감전의 원인이
됩니다.  내부에 이물질이 들어간 경우 즉
시 전원 코드를 분리하고 공인 Roland DG
Corp. 판매점에 문의하십시오.

기기를 장기간 사용하지 않을 경우 전원 
코드를 뽑으십시오. 
이는 예상치 못한 누전 또는 기기의 의도
하지 않은 작동으로 인한 사고를 방지합니
다.

액세서리(옵션 및 소모품, 전원 코드 등)
는 이 기기와 호환되는 정품만 사용하십시
오.
호환되지 않는 품목은 사고로 이어질 수 있
습니다.

전원 코드, 플러그 및 전기 콘센트에 대한 중요 참고 사항.

전원 코드 위에 물건을 
올려 놓거나 손상시키
지 마십시오.

무리한 힘으로 구부
리거나 비틀지 마십
시오.

무리한 힘으로 당기
지 마십시오.

묶거나 말아 놓지 
마십시오.

절대 젖은 손으로 플러
그를 만지지 마십시오.

절대로 열을 가하지 
않습니다.

먼지로 인해 화재가 
발생할 수 있습니다.

이 기기는 무거운 기기입니다.

 주의

평평하고 안정된 위치에 설치합니다.
부적절한 위치에 설치하면 기기가 떨어지
거나 넘어질 수 있습니다.
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안 전 한  사 용 을  위 해

경고 라벨

위험 상황을 즉시 제거하기 위해 경고 라벨이 기기에 부착되어 있습니다.  이러한 라벨의 의미는 다
음과 같습니다.  경고에 주의하십시오.  또 라벨을 제거하거나 지우지 않습니다.

주의 :  고열  
각인 후 즉시 만지지 마십
시오

헤드가 과열됩니다.

경고
각인이 끝난 직후에는 절대로 헤드를 만지
지 마십시오.  
화상을 입을 수 있습니다.
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 Pour utiliser en toute sécurité

La manipulation ou l’utilisation inadéquate de cet appareil peuvent causer des blessures ou des 
dommages matériels. Les précautions à prendre pour prévenir les blessures ou les dommages 
sont décrites ci-dessous.

Avis sur les avertissements

 ATTENTION
Utilisé pour avertir l’utilisateur d’un risque de décès ou de blessure grave en cas de 

mauvaise utilisation de l’appareil.

 PRUDENCE
Utilisé pour avertir l’utilisateur d’un risque de blessure ou de dommage matériel en 

cas de mauvaise utilisation de l’appareil.

* Par dommage matériel, il est entendu dommage ou tout autre effet indésirable

sur la maison, tous les meubles et même les animaux domestiques.

À propos des symboles
Le symbole  attire l’attention de l’utilisateur sur les instructions importantes ou les 

avertissements.

Le sens précis du symbole est déterminé par le dessin à l’intérieur du symbole .

Le symbole à gauche signifie « danger d’électrocution ».

Le symbole  avertit l’utilisateur de ce qu’il ne doit pas faire, ce qui est interdit.

Le sens précis du symbole est déterminé par le dessin à l’intérieur du symbole .

Le symbole à gauche signifie que l’appareil ne doit jamais être démonté.

Le symbole  prévient l’utilisateur sur ce qu’il doit faire.

Le sens précis du symbole est déterminé par le dessin à l’intérieur du symbole .

Le symbole à gauche signifie que la fiche du câble d’alimentation doit être débranchée 

de la prise.
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 Pour utiliser en toute sécurité

 ATTENTION
To u j o u r s  d é b r a n c h e r  l e  c â b l e 
d’alimentation lors de la fixation ou du 
retrait de pièces et de pièces en option et 
du nettoyage ou des travaux d’entretien 
qui n’exigent pas un branchement de 
l’appareil à une source d’alimentation.
Tenter ces opérations pendant que l’appareil 
est branché à une source d’alimentation peut 
causer des blessures ou un choc électrique.

Garder les enfants loin de l’appareil.
L’appareil comporte des zones et des composants 
qui présentent un danger pour les enfants et qui 
pourraient causer des blessures, la cécité, la suf-
focation ou d’autres accidents graves.

Ne jamais tenter de démonter, de réparer 
ou de modifier l’appareil.
Le non-respect de cette consigne risque de 
provoquer un incendie, un choc électrique 
ou des blessures. Confier les réparations 
à un technicien ayant la formation requise.

Ne jamais faire fonctionner l’appareil 
après avoir consommé de l’alcool ou des 
médicaments, ou dans un état de fatigue.
L’utilisation de l’appareil exige un jugement 
sans faille. L’utilisation avec les facultés af-
faiblies pourrait entraîner un accident.

Ne jamais grimper ni s’appuyer sur l’appareil.
L’appareil n’est pas conçu pour sup-
porter le poids d’une personne. Grimper 
ou s’appuyer sur l’appareil peut déplacer 
des éléments et causer un faux pas ou une 
chute, ce qui causerait des blessures.

Être attentif dans le périmètre de l’outil 
de coupe.
L’outil de coupe est acéré. Les outils de 
coupes brisés sont aussi dangereux. Faire 
preuve de prudence pour éviter les blessures.

Ne jamais utiliser un outil de coupe 
émoussé. Procéder fréquemment aux 
travaux d’entretien pour garder l’appareil 
en bon état de fonctionnement.
L’utilisation inappropriée peut provoquer un 
incendie ou des blessures.

Ne pas utiliser l’appareil si le couvercle 
est fissuré ou brisé.
Le non-respect de cette consigne peut cau-
ser des blessures. Si le couvercle est fissuré 
ou brisé, communiquer avec le représentant 
Roland DG autorisé.

S’assurer de suivre les procédures d’utili-
sation décrites dans le manuel utilisateur. 
Ne jamais permettre à des personnes non 
formées à l’utilisation ou à la manipula-
tion de l’appareil de le toucher.
Une manipulation inappropriée de l’appareil 
peut entraîner des blessures imprévues.

Utiliser l’appareil dans un endroit propre 
et bien éclairé.
Travailler dans un endroit sombre ou en-
combré peut entraîner un accident; l’utili-
sateur risque, par exemple, de trébucher 
malencontreusement et d’être coincé par 
une partie de l’appareil.

Ne jamais tenter de démonter, de réparer 
ou de modifier l’adaptateur de c.a.
Le non-respect de cette consigne risque de 
provoquer un incendie, un choc électrique 
ou des blessures. Confier les réparations 
à un technicien ayant la formation requise.

 Une utilisation incorrecte peut causer des blessures
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 Pour utiliser en toute sécurité

 ATTENTION
Brancher à une prise électrique con-
forme aux caractéristiques de cet ap-
pareil (tension, fréquence et courant).
Une tension incorrecte ou un courant insuffisant 
peuvent causer un incendie ou un choc électrique.

Caractéristiques

S’il se produit des étincelles, de la fumée, une 
odeur de brûlé, des bruits inhabituels ou un fonc-
tionnement anormal, débrancher immédiatement 
le câble d’alimentation.Ne jamais utiliser si un 
composant est endommagé.
Continuer à utiliser l’appareil peut causer un incendie, 
un choc électrique ou des blessures. Communiquer 
avec le représentant Roland DG autorisé.

Ne jamais utiliser à l’extérieur ni à un endroit 
où l’appareil risque d’être exposé à l’eau ou 
à une forte humidité. Ne pas toucher le câble 
d’alimentation, la fiche ou la prise électrique 
avec des mains mouillées.
Le non-respect de cette consigne risque de 
provoquer un incendie ou un choc électrique.

Placer l’appareil de façon à ce que la 
fiche soit facile d’accès en tout temps.
Ainsi, l’appareil pourra être débranché rapidement 
en cas d’urgence. Installer l’appareil près d’une prise 
électrique. En outre, prévoir suffisamment d’espace 
pour que la prise électrique soit facile d’accès.

Ne pas utiliser une source d’alimentation au-
tre que celle fournie par l’adaptateur CA dédié.
L’utilisation de l’appareil avec une autre 
source d’alimentation peut provoquer un 
incendie ou un choc électrique.

Ne jamais placer d’objet inflammable à 
proximité de l’appareil. Ne jamais utiliser de 
produit inflammable en aérosol à proximité 
de l’appareil. Ne jamais utiliser l’appareil dans 
un endroit où des gaz peuvent s’accumuler.
Une combustion ou une explosion pour-
raient se produire.

Manipuler le câble d’alimentation, la fiche et 
la prise électrique correctement et avec soin. 
Ne jamais utiliser un article endommagé; 
cela pourrait provoquer un incendie ou un 
choc électrique.

Si une rallonge ou une barre multiprise 
sont utilisées, s’assurer qu’elles cor-
respondent aux caractéristiques de 
l’appareil (tension, fréquence et courant).
Surcharger une prise unique ou utiliser une 
longue rallonge peuvent causer un incendie.

Ne jamais utiliser l’appareil à des fins autres 
que celles pour lesquelles il est conçu. Ne ja-
mais l’utiliser de manière abusive ou excessive.
Le non-respect de cette consigne peut 
provoquer des blessures ou un incendie.

 ATTENTION
Fixer solidement l’outil de coupe et la 
pièce à travailler. Une fois qu’ils sont so-
lidement fixés, s’assurer qu’aucun outil ni 
aucun autre objet n’a été laissé en place.
Si tel était le cas, ces objets pourraient être 
projetés avec force hors de l’appareil et 
causer des blessures.

Faire preuve de prudence pour éviter 
l’écrasement ou le coincement.
La main ou les doigts peuvent être écrasés 
ou coincés s’ils entrent accidentellement 
en contact avec certaines surfaces. Faire 
preuve de prudence lors de l’utilisation de 
l’appareil.

 Certains éléments peuvent présenter un risque de pincement, d’emmêlement, de brûlure ou d’autres dangers.

 Risque de décharge ou de choc électrique, d’électrocution ou d’incendie
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 Pour utiliser en toute sécurité

 ATTENTION
Ne pas utiliser le câble d’alimentation 
ni l’adaptateur CA fournis avec d’autres 
produits.

Ne jamais insérer d’objet étranger dans 
l’appareil. Ne jamais exposer l’appareil 
aux déversements de liquides.
L’insertion d’objets comme des pièces de 
monnaie ou des allumettes, ou le déverse-
ment de liquides dans les orifices de ventila-
tion peuvent provoquer un incendie ou un choc 
électrique. Si un objet ou du liquide s’infiltre 
dans l’appareil, débrancher immédiatement le 
câble d’alimentation et communiquer avec le 
représentant Roland DG autorisé.

Si l’appareil doit rester inutilisé pendant 
une longue période, débrancher le câble 
d’alimentation.
Cela peut prévenir les accidents en cas de 
fuite de courant inattendue ou de démar-
rage accidentel.

Utiliser uniquement des accessoires 
d’origine (accessoires en option et 
consommables, câble d’alimentation et 
autres articles similaires) compatibles 
avec l’appareil.
Les articles incompatibles peuvent entraî-
ner des accidents.

 Remarques importantes à propos du câble d’alimentation, de la fiche et de la prise électrique.

Ne jamais déposer d’objets 
sur le câble d’alimentation 

ou faire quoi que ce soit 
qui pourrait l’endommager.

Ne jamais plier ni 
tordre avec une force 

excessive.

Ne jamais tirer avec une 
force excessive.

Ne jamais lier ni 
enrouler.

Ne pas exposer à l’eau. Ne pas exposer à la 
chaleur.

La poussière peut 
causer un incendie.

 PRUDENCE
Installer l’appareil à un endroit stable 
et plat.
Installer l’appareil à un endroit inapproprié 
peut provoquer sa chute ou son renversement.

 Cet appareil est lourd.
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 Pour utiliser en toute sécurité

Des vignettes d’avertissement sont apposées sur l’appareil pour qu’il soit facile de repérer les 
zones dangereuses. La signification des vignettes est donnée ci-dessous. Respecter les aver-
tissements. Ne jamais retirer les vignettes et ne pas les laisser s’encrasser.

Attention : température élevée.
Ne pas toucher immédiatement 
après l’impression.

 ATTENTION
Ne jamais toucher la tête de l’appareil im-
médiatement après la fin de l’impression.
Le non-respect de cette consigne peut 
causer des brûlures.

 La tête devient chaude.

 Vignettes d’avertissement
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취급 및 사용에 대한 중요 참고 사항

이 기기는 정밀 기기입니다. 이 기기의 완전한 성능을 보장하려면 다음 중요 사항을 준수하십시오.
이러한 사항을 지키지 않으면 성능이 저하 될뿐만 아니라 오작동 또는 고장이 발생할 수 있습니다.

이 기기는 정밀 기기입니다.

• 기기를 조심스럽게 다루고 충격이나 과도한 힘 을 가 하 지 마 십 시 오 .
• 사양 범위 내에서 사용하십시오.

이 기기를 적절한 위치에 설치하십시오.

• 온도, 습도 등에 대해 지정된 조건을 충족하는 위치에 기기를 설치하십시오.
• 이 기기를 올바른 작동 조건을 제공하는 안정적인 위치에 설치하십시오.
• 실리콘 물질(기름, 그리스, 스프레이 등)이있는 환경에서 이 기기를 사용하지 마십시오.   그런 

경우 스위치 접촉 불량이 발생할 수 있습니다.

기기 이동

• 기기를 이동할 때는 반드시 두 손으로 바닥을 받쳐 주십시오.  다른 위치를 잡고 기기를 이동하
려고 하면 손상될 수 있습니다.

기기를 이동할 때 베이스 유닛과 리테이너를 반드시 부착하십시오.  특히, 리테이너를 부착하지 
않고 기기를 이동하면 파손될 수 있습니다.  소재 리테이너 및 그리드 테이블과 같은 포함된 항목
도 제거해야 합니다.
 P.134 “기기의 이동”

각인에 대하여

• 선이나 구멍이 있는 소재 영역에는 절대 각인을 시도하지 마십시오.
• 각인 결과는 소재의 경도에 따라 달라집니다.  실제 각인을 수행하기 전에 테스트 각인을 수행하는 
것이 좋습니다.
• 소재를 넣지 않은 상태에서 반복적으로 각인을 수행하면 핀 손상 및 헤드 오작동이 발생할 수 있습
니다.
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사용자 설명서에 대하여

기기에 포함된 문서
다음 문서가 기기와 함께 제공됩니다.

MPX-95 사용자 설명서(이 문서 : 영문판으로 제공됩니다.)
여기에는 안전한 사용을 위한 중요 참고 사항과 기기 설치 및 작동 방법에 대한 자세한 정보가 포함
되어 있습니다.  이 설명서는 제공된 소프트웨어를 설치하고 사용하는 방법에 대한 지침도 제공합니
다.  

METAZA Driver 2 Help (전자문서)

METAZAStudio Help (전자문서)

SFEdit2 Help (전자문서)

Dr. Engrave Help (전자문서)

이 사용자 설명서는 컴퓨터 화면에서 보기 위한 것입니다.  해당 프로그램을 설치하면 볼 수 있습니
다.  각 소프트웨어가 설치된 후 Dr. Engrave 도움말이 표시됩니다.

 P.26 “METAZA 드라이버 2 인쇄 기본 설정 화면을 여는 방법” 
 P.28 “소프트웨어 도움말을 표시하는 방법”

다음 URL 또는 QR 코드에서 사용자 매뉴얼을 보고 다운로드할 수 있습니다.

* 종이 매뉴얼도 열람 및 다운로드가 가능합니다.
* 이 웹사이트는 스마트폰에서도 볼 수 있습니다.

MPX-95 GK-1
https://downloadcenter.rolanddg.com/MPX-95_GK-1

MPX-95 DK-1
https://downloadcenter.rolanddg.com/MPX-95_DK-1
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이 기기에 대하여

특징
이 기기는 다음과 같은 기능을 가진 금속 프린터입니다.

간단한 입력으로 고품질 마킹

헤드에 장착된 마킹 핀을 이용하여 디테일하게 포인트를 쳐서 이미지를 각인합니다.  
전용 소프트웨어를 사용하여 쉽게 각인 데이터를 생성할 수 있습니다.

수월한 위치 정렬을 위한 레이저 포인터

레이저 포인터를 사용하면 버튼을 한 번 눌러 각인 위치 정렬을 수월하게 수행할 수 있습니다.

연속 인쇄를 위한 가변 각인

다른 여러 코드를 연속으로 각인하는 경우에도 인쇄할 개별 데이터를 입력하기 위해 멈추지 않고 연
속으로 각인을 계속할 수 있습니다.

다양한 소재 지원

더 두꺼운(높은) 소재로도 각인이 가능합니다.
또 다양한 모양의 소재를 장착하도록 설계된 소재 리테이너를 사용하여 사용 가능한 소재 선택이 더 
다양해집니다.
*소재 리테이너는 제공 품목 또는 옵션 키트로 제공됩니다.
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이 기 기 에  대 하 여

옵션 키트에 대하여
다양한 모양의 소재를 장착할 수 있는 소재 리테이너는 별도로 제공됩니다.
애플리케이션과 일치하는 소재 리테이너를 구입하십시오.
구매 정보는 공인 Roland DG Corporation 대리점에 문의하거나 당사 웹사이트
(http://www.rolanddg.kr/)를 방문하십시오.

Gift Kit(기프트 킷)

이 키트를 사용하면 이름, 장식 및 기타 표시를 액세서리에 각인할 수 있습니다.  전용 바이스와 함께
사용하면 시계, 펜 등 쉽게 고정되지 않는 작은 소품에도 각인이 가능합니다.  자세한 사항은 Gift Kit
에 제공된 설명서의 'Using the Gift Kit(Gift Kit 사용하기)'를 참고하세요.

DPM Kit(디피엠 킷)

이 키트를 사용하면 의료 기기 및 산업 제품에 효율적으로 넘버링을 추가할 수 있습니다.  DPM Kit를
이용하면 쉽게 고정할 수 없는 얇은 의료기기는 물론 다양한 모양의 기기에 직접 각인할 수 있습니다.
또 제공된 소프트웨어를 사용하여 2D 기호를 만들고 각인할 수 있습니다.  자세한 내용은 DPM Kit에
제공된 설명서의 "Using the DPM Kit(DPM Kit 사용하기)"을 참조하세요.

19



1

시
작

하
기

 

이 기 기 에  대 하 여

각 부의 명칭

본체

전면

베이스 유닛
베이스 유닛은 다음과 같이 두 부분으로 구성되며 
기기에 설치하거나 제거할 수 있습니다.

 P.37 "베이스 플레이트 설치/제거"

커버

헤드 유닛

커버를 열 때 커버의 
중간 부분을 잡으십시오.

노브 

헤드

베이스 유닛 후크
(좌우 각각 1개씩)

베이스 플레이트

베이스 테이블 
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측면

전원 코드
연결부

USB 연결부

전원/이동 버튼레이저 포인터 버튼

헤드(MPH-90)

이 프린트 헤드는 끝에 마킹 핀을 포함합니다.  마킹 핀의 끝에 다이아몬드가 붙어 있습니다.  헤드
는 소모품이므로 적절한 시기에 교체하십시오.

 P.113 "헤드 교체"

마킹 핀

소재 리테이너

그리드 테이블, 접착 시트

그리드 테이블을 사용하여 소재를 고정할 때 접착 시트를 그리드 테이블에 놓고 소재를 시트 위에 
놓습니다.  시중에서 판매하는 테이프 등을 사용하지 않고도 어느 정도는 소재를 고정할 수 있습니
다.

 P.61 "2.  그리드 테이블에 소재 장착"

접착 시트

그리드 테이블
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제공된 품목 확인
다음 품목은 기기와 함께 제공됩니다.  그들이 모두 존재하고 설명되어 있는지 확인하십시오.

AC 어댑터(1) 전원 코드(1) USB 케이블(1)

그리드 테이블(1) 접착 시트(1) 헤드(MPH-90)(1)*1

헤드캡(둥근타입)(10)*2 테스트 소재
(Brass도금 플레이트)(4) 테스트 소재(MD-NI)(1)

육각 렌치(1) DGSHAPE 소프트웨어 CD (1) 사용자 설명서
(현재 문서:영문판)(1)

*1 : 포장 전에 기기에 조립되어 있습니다.
*2 : 포장 전에 기기에 한개 장착되어 있습니다.  나머지 구성품은 포장되어 제공됩니다.
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소프트웨어 설치

시스템 요구 사항

운영체제 * Windows 10, 8.1(32비트 및 64비트 버전)

프로세서 Intel® Core 2 Duo 이상(Core i5 이상 권장)

메모리 1GB 이상(2GB 이상 권장)

광학 드라이브 CD-ROM 드라이브

그래픽 카드와 모니터 1024 × 768 이상의 해상도에서 최소 16비트 색상(하이 컬러) 권장

설치에 필요한 
하드 디스크 여유 공간 25 MB

* 이 소프트웨어는 32비트 응용 프로그램이므로 WOW64(또는 Windows-On-Windows 64)에
서 실행됩니다.  64비트 버전의 Windows.

최신 정보는 RolandDG Corporation 웹사이트(http://www.rolanddg.kr/)를 참조하십시오.

설치 및 설정할 수 있는 소프트웨어

METAZAStudio 각인 데이터를 생성하는 프로그램입니다.  각인할 이미지를 가져오고 
자르고 텍스트, 상자 등을 추가하는 편집을 수행할 수 있습니다.

SFEdit2

이 프로그램을 사용하면 스트로크 문자 글꼴을 만들고 편집할 수 있
습니다.  스트로크 문자 글꼴은 트루타입 글꼴에서 중심선을 자동으
로 추출하여 만든 라인입니다.  METAZAStudio에서 생성된 스트로크
문자 글꼴을 글꼴로 사용할 수 있습니다.

MPX-95 Head Manager
헤드를 조정하는 유틸리티입니다.  헤드를 교체하거나 마킹 핀을 
조정할 때 실행하십시오.

Dr. Engrave
각인 데이터를 생성할 수 있는 텍스트 및 이미지 각인 소프트웨어입
니다.  Windows에 등록된 TrueType 글꼴을 사용할 수 있습니다.  
스트로크 문자도 있습니다.

METAZA Driver 2 이 Windows 드라이버는 컴퓨터에서 기기로 데이터를 전송할 때
필요합니다.
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드라이버 및 소프트웨어 설치

IMPORTANT

절차에 따라 기기를 컴퓨터에 연결했는지 확인하십시오.  올바른 절차를 따르지 않으면 설치가 
불가능할 수 있습니다.

절차

A 설치 및 설정을 시작하기 전에 USB 케이블이 연결되어 있지 않은지 확인하십시오. 

B 관리자 또는 관리자 그룹의 구성원으로 Windows에 로그온합니다. 

C DGSHAPE 소프트웨어 패키지 CD를 컴퓨터에 넣습니다.
자동 실행 창이 나타나면 [메뉴 실행]을 클릭합니다.  [사용자 계정 컨트롤] 창이 나타나면 
[허용] 또는 [예]를 클릭합니다.  설치 메뉴가 자동으로 나타납니다.

D [Install]을 클릭합니다.

설치할 드라이버와 소프트웨어가 표시됩니다.

E [OK]를 클릭합니다.

METAZA Driver 2 및 각 소프트웨어가 한 번에 모두 설치됩니다.
 P.23 "설치 및 설정할 수 있는 소프트웨어"

METAZA 드라이버 2와 각 소프트웨어를 별도로 설치할 수 있습니다.
 P.127 "드라이버를 별도로 설치", P.130 "소프트웨어를 별도로 설치"
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F [Install]을 선택하고 모델명으로 [Roland MPX-95]를 선택, 포트는 [USB]를 선택한 후 
[Start]를 클릭합니다.

설치가 시작됩니다.  화면의 지시에 따라 진행하십시오.

설치 중에 아래와 같은 화면이 나타나면 다음 작업을 수행하십시오.

Windows 10

[Install]을 클릭합니다.
Windows 8.1

[Install]을 클릭합니다.

G 표시된 지침을 따르고 설치를 계속하십시오.
각 소프트웨어 항목에 대한 설치 정보는 필요에 따라 자동으로 표시됩니다.

H 다음 창이 나타나면 [OK]를 클릭합니다.

이것으로 모든 항목의 설치가 완료됩니다.

I 설치가 완료되면 설치 메뉴에서          를 클릭합니다.
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J 컴퓨터에서 DGSHAPE 소프트웨어 패키지 CD를 꺼냅니다.

IMPORTANT

이 시점에서 METAZAStudio Driver 2는 아직 설치되지 않았습니다.
다음 단계에서 기기가 컴퓨터에 연결되면 설치가 자동으로 수행됩니다.

 P.31 "기기를 컴퓨터에 연결"

METAZA 드라이버 2 인쇄 기본 설정 화면을 여는 방법

METAZA 드라이버 2 설치가 완료된 후 인쇄 기본 설정 화면을 표시할 수 있습니다.

A 프린터 아이콘을 표시합니다.

Windows 10

① 컴퓨터에서 [시작] 메뉴를 클릭합니다.
② [Windows 시스템]을 클릭한 후 [제어판]을 클릭합니다.
③ [장치 및 프린터 보기]를 클릭합니다.

Windows 8.1

① 컴퓨터에서 [시작] 메뉴를 마우스 오른쪽 버튼으로 클릭합니다.
② [제어판]을 클릭합니다.
③ [장치 및 프린터]를 클릭합니다.

B [Roland MPX-95] 아이콘을 마우스 오른쪽 버튼으로 클릭하고 [인쇄 기본 설정]을 클릭합니다.
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METAZA 드라이버 2의 인쇄 기본 설정 화면이 열립니다.

METAZA 드라이버 2 도움말을 여는 방법

METAZA Driver 2 인쇄 기본 설정 화면을 열고 [Help]를 클릭합니다.
 P.26 "METAZA 드라이버 2 인쇄 기본 설정 화면을 여는 방법"
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소프트웨어 시작 방법

Windows 10

① [시작] 버튼을 클릭합니다.
② [모든 앱]을 클릭합니다.
③ [(Roland METAZAStudio)] 폴더 아래에 있는 [(METAZAStudio)] 아이콘을 클릭합니다.

Windows 8.1

① [시작] 화면에서        를 클릭합니다.
② [앱] 화면에서 [(METAZAStudio)]를 클릭합니다.

소프트웨어 도움말을 표시하는 방법

소프트웨어를 시작한 다음 메뉴에서 [Help] → [Contents]를 클릭합니다.
 P.28 "소프트웨어 시작 방법"
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설치 환경

물이나 높은 습도에 노출될 수 있는 장소 또는 외부에 설치하지 마십시오.

누전으로 인해 감전 또는 화재가 발생할 수 있습니다.

가연성 물체 가까이 또는 가스가 가득한 장소에 기기를 설치하지 마십시오.

연소 또는 폭발이 발생할 수 있습니다.

전원 플러그가 항상 즉시 닿을 수 있는 위치에 두십시오.

이는 비상시 전원 플러그를 빠르게 분리할 수 있도록 하기 위한 것입니다.  전기 
콘센트 옆에 기기를 설치하세요.  또 전기 콘센트에 즉시 접근할 수 있도록 충분
한 빈 공간을 확보 합니다.

	 평평하고 안정된 위치에 설치합니다.

그렇지 않으면 기기가 떨어져 부상을 입을 수 있습니다.

• 온도나 습도의 변동이 심한 장소에는 절대 설치하지 마십시오.
• 흔들리거나 진동이 있는 장소에는 절대 설치하지 마세요.
• 바닥이 기울어지거나 평평하지 않거나 불안정한 곳에 설치하지 마십시오.
• 먼지가 많거나 더러운 장소 또는 문 밖에 설치하지 마십시오.
• 직사광선이 닿는 장소나 냉난방 시설 근처에 설치하지 마세요.
• 강한 전기 또는 자기장 또는 기타 형태의 전자기 에너지에 노출된 위치에 설치하지 마십시오.
• 실리콘 물질(기름, 그리스, 스프레이 등)이 있는 환경에는 절대 설치하지 마십시오.  스위치 접촉

불량의 원인이 됩니다.

경고 

경고 

경고 
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설 치

리테이너 제거
운송 중 기기의 진동을 방지하기 위해 리테이너가 부착되어 있습니다.  설치가 완료되면 이러한 구
성 요소를 제거하고 보관합니다.

리테이너 제거

기기는 5개 지점(아래 ①에서 ⑤까지)에서 리테이너와 나사로 고정됩니다.  제공된 육각 렌치를 사
용하여 모든 나사와 리테이너를 제거합니다.  리테이너 또는 나사가 남아 있으면 전원을 켤 때 오작
동 또는 고장의 원인이 될 수 있습니다.

사 용  품 목 리 테 이 너

육각 렌치 리테이너 A(2) 리테이너 B(좌 우 각 1개) 고정 나사(7)

리테이너 B

기기의 왼쪽과 
오른쪽에 고정되
어 있습니다.

리테이너 A

리테이너  A

보관

기기를 다른 위치로 이동할 때 리테이너와 나사가 필요합니다.  제거한 나사와 리테이너(A)를 기기 
뒷면 하단에 장착하여 보관합니다.  리테이너 B는 기기에 부착할 수 없으며 분실되지 않도록 별도로 
보관해야 합니다.

후면

30
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기기를 컴퓨터에 연결

	

	

	

	

AC 어댑터에 표시된 정격에 맞지 않는 전원 공급 장치를 사용하지 마십시오.
다른 전원을 사용하면 화재나 감전의 위험이 있습니다.

기기와 함께 제공된 AC 어댑터 및 전원 코드 이외의 AC 어댑터 또는 전원 코
드를 사용하지 마십시오.

다른 전원을 사용하면 화재나 감전의 위험이 있습니다.

AC 어댑터를 분해, 수리 또는 개조하지 마십시오.

화재, 감전 또는 부상을 입을 수 있습니다.  숙련된 서비스 기술자에게 수리
를 맡기십시오.

연장 코드나 멀티탭을 사용할 때는 기기의 정격(전압, 주파수, 전류)에 맞는 
것을 사용합니다. 

하나의 콘센트에 여러 개의 전기 장치를 사용하거나 긴 연장 코드를 사용하
면 화재가 발생할 수 있습니다.

절차

A 기기의 전원을 켭니다.
헤드 스토퍼를 푸는 것을 잊지 마십시오. 
 P.32 "전원 켜기"

B USB 케이블을 사용하여 기기를 컴퓨터에 연결합니다.

IMPORTANT

• 한 대의 컴퓨터에 여러 대의 기기를 연결하지 마십시오.
• 제공된 USB 케이블을 사용하십시오.
• USB 허브를 사용하지 마십시오.

METAZA Driver 2와 개별 소프트웨어가 자동으로 설치됩니다.

MPX-95

전기 콘센트 

전원 코드

AC 어댑터

컴퓨터
31



전원 켜기 및 끄기

전원 켜기

절차

A 기기의 하단 커버를 엽니다.

B 헤드 스토퍼를 풉니다.
노브를 한 번 돌립니다.

스토퍼

풀림

C 전원/이동 버튼을 누릅니다.
헤드가 왼쪽 뒤쪽으로 이동하고 전원/이동 버튼의 램프가 켜집니다.  이 작업을 초기 동작
이라고 합니다.

1
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IMPORTANT : 전원 램프가 계속 깜박이는 경우

초기 동작 오류입니다.  헤드 스토퍼를 풀고 전원/이동 버튼을 누릅니다.  오류가 해결되고 전원 램프가 
켜집니다.

램프가 계속 깜박이면 다음 섹션을 참조합니다.

 P.118 "[전원/이동] 버튼이 깜박이는 경우"

전원 끄기

절차

전원/이동 버튼을 1초 이상 누른상태를 유지 합니다.

표시등이 꺼지고 전원이 꺼집니다.
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전 원  켜 기  및  끄 기
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베이스 유닛 설치/제거

베이스 유닛은 기기에 설치하거나 제거할 수 있습니다.  베이스 유닛은 베이스 테이블과 베이스 플레
이트를 포함하며, 둘 다 필요에 따라 결합되어 다양한 형태의 소재에 각인이 가능합니다.

 P.42 "소재 준비"

베이스
테이블

베이스
플레이트

베이스 
유닛

본체

• 베이스 유닛(또는 베이스 플레이트)을 설치하거나 제거하기 전에 전원을 끄십시오.  베이스 유
닛(또는 베이스 플레이트)은 전원이 켜진 상태에서도 설치 또는 제거가 가능하지만 헤드 부분에 
접촉하면 각인 위치가 어긋날 수 있습니다.

• 제거한 베이스 테이블, 베이스 플레이트, 그리드 테이블은 안정된 위치에 수평으로 보관하십시
오.
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베이스 플레이트에 베이스 테이블(또는 그리드 테이블) 설치/제거

MEMO

• 베이스 테이블(또는 그리드 테이블)은 베이스 플레이트가 기기에 부착된 상태로 설치/제거될 
수 있습니다.
• 베이스 테이블 뿐만 아니라 그리드 테이블도 베이스 플레이트에 직접 장착할 수 있습니다.
 P.61 "2.  그리드 테이블에 소재 장착"

베이스 테이블(또는 그리드 테이블) 제거

절차

A 기기의 하단 커버를 엽니다.

B 베이스 테이블(또는 그리드 테이블)을 수직으로 들어 올려 베이스 플레이트에서 제거합니다.
양손으로 베이스 테이블을 들어올립니다.

베이스 테이블의 경우 그리드 테이블의 경우

1
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베 이 스  유 닛  설 치 / 제 거
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베이스 테이블(또는 그리드 테이블) 설치

절차

A 기기의 하단 커버를 엽니다.

B 베이스 플레이트가 설치되어 있는지 확인하십시오.

C 베이스 플레이트에 베이스 테이블(또는 그리드 테이블)을 놓습니다.

베이스 테이블(또는 그리드 테이블) 바닥의 돌출부를 베이스 플레이트의 구멍에 일치 시킵니다.

베이스 테이블의 경우 그리드 테이블의 경우

모서리와 
맞춥니다.
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베 이 스  유 닛  설 치 / 제 거
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베이스 플레이트 설치/제거

MEMO

• 베이스 유닛은 공장에서 배송될 때 미리 설치되어 출고 됩니다.
• 그리드 테이블과 베이스 유닛(또는 베이스 플레이트)이 기기에 장착되었는지 확인하고 소재를 

장착합니다.
 P.61 "2.  그리드 테이블에 소재 장착"

베이스 플레이트 제거

절차

A 기기의 하단 커버를 엽니다.

B 기기 양쪽의 후크를 해제합니다.

C 베이스 플레이트를 양손으로 잡고 똑바로 앞으로 당깁니다.
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베이스 플레이트 설치

절차

A 기기의 하단 커버를 엽니다.

B 베이스 플레이트를 양손으로 잡고 기기의 돌출부를 베이스 플레이트의 구멍에 삽입합니다.

동시에 두 위치의 구멍에 똑바로 
삽입합니다.

본체

베이스 플레이트

C 기기 양쪽의 후크가 베이스 플레이트에 걸리도록 장착하고 후크를 잠급니다.

OK Not OK Not OK

IMPORTANT

기기 양쪽의 고리가 단단히 잠겨 있는지 확인하십시오.  잠금 장치가 제대로 되어 있지 않거나 한쪽만 
잠긴 경우 베이스 유닛이 움직여 각인 위치가 어긋날 수 있습니다.
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40

각인 워크플로우 확인

METAZAStudio의 출력 기기 선택(P. 41)

기기의 전원을 켜고 컴퓨터에서 출력 기기를 선택합니다.

소재 준비(P. 42)

각인할 소재가 충족해야 하는 두께, 경도 등 여러 조건을 확인합니다.

각인 데이터 생성(P. 48)

METAZAStudio를 사용하여 각인 데이터를 생성합니다.

소재 장착(P. 60)

기기에 소재를 장착합니다.

각인 시작(P. 66)

METAZAStudio에서 각인 데이터를 출력합니다.

각인 준비
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각 인  준 비

METAZAStudio의 출력 기기 선택

절차

A 기기의 전원을 켭니다.
 P.32 "전원 켜기"

B METAZAStudio를 시작합니다.
 P.28 "소프트웨어 시작 방법"

C [File] → [Set up the printer]를 클릭합니다.

[Print Setup] 대화 상자가 나타납니다.

D 데이터를 출력할 프린터를 선택합니다.
① [Roland MPX-95]를 선택합니다.
② [OK]를 클릭합니다.

2
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각 인  준 비

소재 준비
이 기기로 소재에 각인을 하려면 소재가 다음 조건을 모두 충족해야 합니다.  이러한 조건에 대한 자
세한 내용은 언급된 해당 페이지를 참조하십시오.

• 각인 표면 경도(P.42)

• 두께(높이)(P.42)

• 사이즈(P.45)

• 모양(P.46)

• 곡면을 각인할 때의 소재의 조건(각인 표면이 곡선인 경우)(P.47)

이러한 조건은 이 기기 및 제공된 품목으로 사용 하는 경우 입니다.  옵션 키트를 사용하는 경우 조건이 
다를 수 있습니다.

각인 표면 경도

200 이하의 비커스 경도(HV)
각인에 의해 깨지거나 갈라질 수 있는 소재(유리, 돌, 보석, 도자기, 도자기 등)는 경도가 범위 내라
도 각인할 수 없습니다.  이러한 소재를 각인하려고 하면 기기가 손상될 수 있습니다.  소재 표면의 
경도에 대한 정보는 소재를 구입한 판매점 또는 소재 제조업체에 문의하십시오.

두께(높이)

각인 가능한 두께(높이)는 베이스 유닛의 조합에 따라 다릅니다.
 P.37 "베이스 유닛 설치/제거"

베이스 
테이블

베이스 
플레이트

베이스 유닛

본체

2
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각인 준비

베이스 유닛 사용하는 경우

소재 두께(높이) 베이스 테이블 

0.3mm~40mm
(0.01in~1.6in) 사용

40 mm~70 mm
(1.6 in~2.8 in) 미사용

* 베이스 테이블 사용 여부에 관계없이 40mm(1.6in) 소재의 각인이 가능합니다.

 베 이 스  테 이 블  +  베 이 스  플 레 이 트

0 . 3 m m ~ 4 0 m m ( 0 . 0 1 i n ~ 1 . 6 i n )

베이스 테이블

베이스 플레이트

소재

그리드 테이블 

베 이 스  플 레 이 트 만  사 용  시

베이스 플레이트

소재
그리드 테이블

4 0  m m ~ 7 0  m m ( 1 . 6 i n ~ 2 . 8 i n )

2
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각 인  준 비

베이스 유닛을 사용하지 않는 경우

소재의 각인 표면이 헤드 캡의 끝에서 최대 70mm(2.8in)까지 각인 가능 영역(마킹 핀이 도달하
는 영역)으로 설정된 경우 두께(높이)가 같거나 큰 소재도 각인할 수 있습니다.

헤드 캡

70mm(2.8in)
각인 가능한 영역

80mm
(3.2in)

118mm(4.6in)
(기기와의 거리)

* 베이스 유닛을 사용하지 않을 경우 그리드 테이블의 고정은 불가능합니다.  소재를 수평으로 
유지하기 위해 지지대를 배치하는 것 외에도 시중에서 구입할 수 있는 테이프 또는 다른 수단을 
사용하여 그리드 테이블을 작업 표면에 고정합니다.
* 베이스 유닛을 사용하지 않으면 각인 위치 정렬 정확도가 감소합니다.  생산을 위해 각인하기 
전에 테스트 각인을 수행하고 위치를 미세 조정합니다.
 P.106 "두꺼운(높은) 소재에 각인"
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각 인  준 비

크기

The instrument is large enough to be firmly secured.
기기 사용 시 접착 시트를 사용하여 소재를 고정할 수 있습니다.  소재의 크기가 접착 시트에서 튀어 
나와도 되지만 필수 요구 사항은 소재를 단단히 고정할 수 있어야 합니다.

다음 표는 소재별 각인 가능한 두께와 크기를 나타낸 것입니다.  단, 두께와 크기가 아래에 명시된 
범위 내라도 각인 시 휘어지는 소재는 사용할 수 없으니 유의하시기 바랍니다.  이러한 소재를 사용
하면 휘어진 소재가 헤드에 닿아 마킹 핀이 손상될 수 있습니다.

소 재 두 께 너 비  및  길 이 ( 일 반  가 이 드 )

알루미늄

2.0mm
(0.08in)

길이(또는 너비)
60mm(2.4in) 이하

1.5mm
(0.06in)

길이(또는 너비)
40mm(1.6in) 이하

1.0mm
(0.04in)

길이(또는 너비)
30mm(1.2in) 이하

0.5mm
(0.02in)

길이(또는 너비)
20mm(0.8in) 이하

0.3mm
(0.01in)

길이(또는 너비)
20mm(0.8in) 이하

황동 또는 구리

2.0mm
(0.08in) 

길이(또는 너비)
60mm(2.4in) 이하

1.5mm
(0.06in) 

길이(또는 너비)
40mm(1.6in) 이하

1.0mm
(0.04in)

길이(또는 너비)
30mm(1.2in) 이하

0.5mm
(0.02in)

길이(또는 너비)
15mm(0.6in) 이하

0.3mm
(0.01in)

길이(또는 너비)
15mm(0.6in) 이하

스테인레스 스틸

2.0mm
(0.08in)

길이(또는 너비)
60mm(2.4in) 이하

1.0mm
(0.04in)

길이(또는 너비)
40mm(1.6in) 이하

* 옵션 키트 소재 리테이너를 사용하는 경우 조건이 다를 수 있습니다. 
 옵션 소재 리테이너용 사용 설명서
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각 인  준 비

모양

각인 표면에 요철이 없어야 합니다.

셋팅시나 각인시 기기의 가동부에 닿는 소재는 각인이 불가능합니다.

소재의 가장자리가 
높은 경우

Not OK

L자형

Not OK
평 면 도  :

단 면 도  :

뒷면은 수평의 차이가 없이 평평해야 합니다.

뒷면이 곡선인 경우

OK

뒷면이 고르지
않은 경우

Not OK Not OK

*  옵션 키트 소재 리테이너를 사용하는 경우 조건이 다를 수 있습니다.

(헤드 캡 미사용 시) 각인할 표면이 평평해야 합니다.

각인할 표면이 평면이
아닌 경우

Not OK
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각인 준비

곡면 각인 시 소재의 조건

아래의 표와 그림은 곡면이 넓은 원통의 직경에 대한 각인 가능 영역과 마킹 핀이 도달하는 영역을 
나타냅니다.  단, 다음과 같은 조건을 전제로 합니다.

• 헤드 캡을 사용합니다.
• 넓은 곡면이 있는 원통형 소재입니다.

곡면을 가진 실린더의 
지름(φ) 권장 각인 영역(A) 마킹 핀(B)이 도달하는 영역

10mm(0.4in) 2.0mm(0.08in) 2.8mm(0.11in)
20mm(0.8in) 2.8mm(0.11in) 4.0mm(0.16in)
30mm(1.2in) 3.4mm(0.14in) 4.8mm(0.19in) 

(0.004in) (0.008in)

* 소재의 모양이나 구성에 관계없이 사진 데이터는 곡면에 각인하기에 적합하지 않습니다.

MEMO

바닥이 평평하지 않은 각인 소재는 옵션 키트의 소재 리테이너를 사용하거나 다른 수단을 사용하여 
고정해야 합니다.

이 섹션에서는 METAZAStudio를 사용하여 각인 데이터를 생성하는 방법을 설명합니다.
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48

METAZAStudio 시작하기

Windows 10
① [시작] 버튼을 클릭합니다.
② [모든 앱]을 클릭합니다.
③ [METAZAStudio] 폴더 아래에 있는 [METAZAStudio] 아이콘을 클릭합니다.

Windows 8.1
① [시작] 화면에서        을 클릭합니다.
② [앱] 화면에서 "METAZAStudio"를 클릭합니다.
 P.49 "METAZAStudio 화면"

METAZAStudio를 시작합니다.

각인 데이터 생성
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각 인  데 이 터  생 성

METAZAStudio 화면

No. 이름 기능 개요

① Menu bar
METAZAStudio의 다양한 기능을 실행합니다.

 METAZAStudio 온라인 도움말("Commands")

② Toolbar
도구 모음에는 [Material] 및 [Open]과 같은 METAZAStudio 명령을 
실행하기 위한 버튼이 있습니다.

 METAZAStudio 온라인 도움말("Commands"-"Toolbar buttons")

③ Page Feed Bar

변수 필드에 데이터를 입력한 경우 이를 사용하여 화면에 표시되는 
페이지(레코드)를 지정합니다.  가변 각인에 사용합니다.

 P.90 "가변 각인 데이터 생성"
 METAZAStudio 온라인 도움말("Hints and Tips">"Performing Variable Imprinting")

④ Status Bar

이것은 커서의 현재 위치, 모양, 격자 및 보기 배율에 대한 정보를 
보여줍니다.  포인터를 도구 모음 버튼으로 이동하거나 메뉴 명령을 
가리키면 버튼 또는 명령에 대한 간략한 설명이 왼쪽 가장자리에 나
타납니다.

현재 커서 위치 커서의 현재 위치를 나타냅니다.  두 개의 중
심선이 교차하는 창의 중심 위치는 (0, 0)입니
다.

형상 정보

이것은 화면상의 개체(이미지, 텍스트 또는 
모양)를 클릭할 때 나타납니다.  아래 그림과 
같이 현재 모양의 중심 위치와 크기가 표시됩
니다.

그리드 피치
그리드 선의 피치(간격)를 표시합니다.  이 위
에 마우스 오른쪽 버튼을 클릭하면 그리드 모
양과 관련된 메뉴 항목이 표시됩니다.

배율 보기
이것은 화면 보기의 현재 배율을 표시합니다.  
이 위에 마우스 오른쪽 버튼을 클릭하면 보기
배율을 변경할 수 있는 메뉴가 표시됩니다.
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각 인  데 이 터  생 성

No. 이름 기능 개요

⑤ Grid table 기기의 그리드 테이블이 표시됩니다.  표시된 눈금은 그리드 테이블
의 실제 눈금 표시를 나타냅니다.

⑥ Work Area
각인이 가능한 영역입니다.  METAZA Driver 2에서 설정한 소재 사
이즈(각인 영역)를 나타냅니다.

 P.104 "기본 드라이버 설정 변경"

⑦ Center line 창의 수직 및 수평 중심을 나타냅니다.

⑧ Grid 작업 영역에 표시되는 그리드 선입니다.   이미지와 텍스트를 배치
하기 위한 가이드 역할을 합니다.

⑨ Margin

이 빈 영역은 작업 영역의 가장자리 내부에 있으며 각인이 수행되지
않습니다.  METAZAStudio 설치 시 기본 설정은 1mm(0.04in)입니
다.  [File] 메뉴에서 [Preferences]를 선택하여 여백의 크기를 변경
할 수 있습니다.

 P.51 "Step 1: 소재의 모양과 크기 결정"
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각 인  데 이 터  생 성

Step 1: 소재의 모양과 크기 결정
METAZAStudio에는 다양한 유형의 소재가 사전 등록되어 있습니다.  이 섹션에서는 아래와 같이 플
레이트를 사용하는 예를 들어 플레이트와 같은 모양의 소재를 "tag"라는 이름으로 사용하는 절차를 
설명합니다.

 P.42 "소재 준비"

25mm(0.98in)

40mm
(1.6in) 

MEMO

새로운 소재를 등록하려면 아래 섹션을 참조하십시오. 
 P.102 "구성 등록 및 타격력 조정"

절차

A METAZAStudio를 시작합니다.
 P.28 "소프트웨어 시작 방법"

[Select Material] 대화 상자가 나타납니다.
METAZAStudio가 이미 실행 중이면       을 클릭하십시오.

[Select Material] 대화 상자가 나타납니다.
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각 인  데 이 터  생 성

B [Select Material] 대화 상자에서 소재를 선택합니다.
[Use printer driver settings] 확인란의 선택을 취소하여 소재 유형을 선택합니다.  목록에 
포함되지 않은 소재를 사용하려면 소재를 등록할 수 있습니다.
 P.102 "구성 등록 및 타격력 조정"

METAZA Driver 2 설정을 변경하지 않고 사용하는 경우 [Use printer driver settings] 
확인란을 선택합니다.

C [OK]를 클릭합니다.

D 를 클릭합니다.

[Material] 창이 나타납니다.
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각 인  데 이 터  생 성

E 소재의 모양을 선택합니다.
① "tag" 이름이 있는 아이콘을 클릭합니다.

② 을 클릭합니다.

[Material Size] 대화 상자가 나타납니다.
③ 소재의 크기 값을 입력합니다.

④ [OK]을 클릭합니다.
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각 인  데 이 터  생 성

선택한 소재가 편집 창에 나타납니다.  소재로 표시되는 부분은 변경 없이 각인 영역이 
됩니다.

F [File] → [Preferences]를 클릭합니다.

[Preferences] 대화 상자가 나타납니다.
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각 인  데 이 터  생 성

G 여백을 설정합니다.

① "Margin"을 "1mm"(0.0394in)로 설정합니다.

② [OK]를 클릭합니다.

IMPORTANT
평평한 소재를 각인하려면 여백을 1mm(0.0394in) 이상으로 만드십시오.  여백을 1mm(0.0394in) 
미만으로 설정하면 마킹 핀이 소재의 가장자리에 부딪혀 손상될 수 있습니다.
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각 인  데 이 터  생 성

Step 2: 이미지 불러오기
각인할 이미지(예: 사진 또는 그림)를 가져옵니다.

METAZAStudio에서 지원하는 데이터 형식
• JPEG 형식

• BMP(비트맵) 형식

• Illustrator 버전 7 또는 8로 만든 AI 또는 EPS 형식의 파일

• CorelDraw 버전 7 또는 8에서 내보낸 AI 또는 EPS 형식의 파일

* Illustrator 및 CorelDraw 파일에는 여러 가지 제한이 있습니다.  자세한 내용은 METAZAStudio의
온라인 도움말을 참조하십시오.

 METAZAStudio 온라인 도움말("Hints and Tips">"Reusing Existing Data")

절차

A 를 클릭합니다.

[Import] 대화 상자가 나타납니다.

B 파일을 엽니다.

① [찾는 위치]에서 파일의 위치를 선택합니다.
② [Files of type]에서 [Picture file] 또는 [Adobe Illustrator file]을 선택합니다.
③ 원하는 파일을 선택하세요.
④ [Open]을 클릭합니다.
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각 인  데 이 터  생 성

지정한 이미지를 가져와서 설정한 여백과 함께 표시합니다.

MEMO

크기나 방향을 변경하거나 테두리를 추가하는 등 배치된 이미지의 배열을 변경할 수 있습니다.
 METAZAStudio 온라인 도움말("Hints and Tips")

IMPORTANT

소재에 구멍이 있는 경우 이미지가 구멍 위에 배치되지 않도록 주의하십시오.  각인 영역에 구멍을 
포함하면 마킹 핀이 소재의 가장자리에 부딪혀 손상될 수 있습니다.

각인 영역 각인 영역

각인 영역

각인 영역

각인 영역이 구멍 
위에 있는 경우

소재의 가장자리
에 여백이 없는 

경우

각인될 영역이 
소재를 넘어간 

경우

OK Not OK Not OK Not OK

1mm
(0.04in) 
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각 인  데 이 터  생 성

Step 3: 텍스트 입력
각인할 텍스트를 입력합니다.

절차

A 를 클릭합니다.

B 텍스트를 입력합니다.

① 각인 영역을 클릭합니다.
② 텍스트를 입력합니다.

입력한 텍스트의 크기와 방향을 변경하고 채울 수 있습니다.
 METAZAStudio 온라인 도움말("Hints and Tips")
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각 인  데 이 터  생 성

Step 4: 각인 데이터 저장
각인 데이터를 파일로 저장합니다.

절차

A 를 클릭합니다.

[Save As] 대화 상자가 나타납니다.

B	 [저장 위치]에서 파일을 저장할 위치를 지정합니다.
파일 이름을 입력합니다.
[Save]을 클릭합니다.
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각인

소재 장착

1. 헤드 캡을 부착합니다.

A 각인 준비가 완료되었는지 확인하십시오.
 P.40 "각인 준비"

B 헤드 유닛이 내려져 있는 경우 전원/이동 버튼을 누릅니다.
머리가 왼쪽 뒤쪽으로 움직입니다.

C 헤드스토퍼를 풉니다.
노브를 한 번 돌립니다.  스토퍼와 링이 서로 접촉합니다.

링

스토퍼

푸는방향

D 헤드 스토퍼를 고정합니다.

노브의 중앙을 바로 아래에 있는 삼각형 표시의 상단과 정렬하고 스토퍼를 고정합니다.  
스토퍼가 느슨한 상태에서 각인을 하면 진동에 의해 노브가 빠질 수 있습니다.

노브

고정방향

노브의 중심은 삼각형표시의 
상단 바로 위에 위치해야 합
니다.
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각인

E 헤드 캡을 헤드의 팁에 장착합니다.

그림과 같이 헤드를 가볍게 잡고 장착하십시오.  탭이 딸깍 소리를 내면 헤드 캡이 올바르
게 부착된 것입니다.

헤드 캡 헤드

헤드 고정

헤 드 캡  사 용 시  주 의 사 항

각인 표면에서 먼지와 이물질을 제거합니다.
인쇄면에 붙은 먼지와 이물질을 제거하지 않고 인쇄를 하면 인쇄 품질이 떨어질 수 있습니다.  각인을 
수행하기 전에 각인 표면에서 먼지와 이물질을 제거했는지 확인하십시오.

테스트 각인의 경우 긁힘이나 얼룩이 없는 재질을 사용하는 것이 좋습니다.
일부 소재는 각인 중 헤드 캡에 긁힘 및 얼룩을 유발할 수 있으며 이는 각인 품질에 영향을 미칠 수 있습
니다.  소재의 긁힘과 얼룩은 헤드 캡을 손상시켜 인쇄 품질을 저하시킬 수 있습니다.  따라서 각인을 
하기 전에 긁힘이나 얼룩이 없는 소재로 테스트 각인을 하시길 권장합니다.

2. 그리드 테이블에 소재 장착

A 베이스 유닛을 기기에 부착합니다.
 P.37 "베이스 유닛 설치/제거"

IMPORTANT

각인할 소재의 두께(높이)에 맞게 베이스 유닛을 부착합니다.  구성이 소재에 적합하지 않은 경
우 인쇄 품질이 저하되고 기기가 손상될 수 있습니다.

 P.42 "소재 준비"
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각인

B 베이스 플레이트에 베이스 테이블(또는 그리드 테이블)을 놓습니다.

그리드 테이블 바닥의 돌출부를 베이스 테이블 또는 베이스 플레이트의 구멍에 삽입합니다. 

베 이 스  테 이 블  +  베 이 스  플 레 이 트  사 용  시

그리드 테이블

베이스 플레이트 상단의 
프레임 및 구멍

베 이 스  플 레 이 트 만  사 용  시

그리드 테이블

베이스 플레이트 구멍

C 그리드 테이블에 접착 시트를 부착합니다.

그리드 테이블 

그리드 테이블용 접착 시트

* 다음 그림은 베이스 테이블을
부착한 모습입니다.

눈금 표시와 시트를 정렬하여 그리드 테이블 프레임 내에서 접착 시트를 똑바로 놓습니다.  
그리드 테이블과 접착 시트 사이에 기포가 형성되지 않도록 주의하십시오.

MEMO

접착력이 저하된 경우 접착 시트를 세척하십시오.  접착 시트를 세탁해야 하는 경우 너무 세게 문질러 
표면이 손상되지 않도록 주의하세요.  그렇게 하면 표면이 손상되고 접착력이 떨어질 수 있습니다.

 P.109 "접착 시트 청소"
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D 레이저 포인터 버튼을 누릅니다.

레이저 포인터가 조사됩니다.  기기가 5분 동안 유휴 상태이면 레이저 포인터가 자동으로 
꺼집니다.

E 접착 시트에 소재를 장착합니다.

레이저 
포인트

각인 영역  

• 레이저 포인터가 소재에 각인될 영역의 중심을 가리키도록 장치를 이동합니다.
• 접착 시트에 붙이듯이 소재를 부드럽게 눌러줍니다.

MEMO

레이저 포인터가 가리키는 위치는 METAZAStudio에서 작업 영역의 중심과 일치합니다.  레이저 포인
터가 가리키는 위치를 각인할 영역의 중심과 일치시키면 METAZAStudio의 작업 영역에 표시된 것과 
똑같은 레이아웃으로 인쇄할 수 있습니다.

소재 배치 방법
• 각인할 영역의 중심이 그리드 테이블의 눈금 중심에 오도록 소재를 배치합니다.
• 소재가 너무 커서 그리드 테이블에 맞지 않으면 소재를 수평으로 유지하기 위해 필요한

만큼 지지대를 사용하십시오.

각인 영역의 
중심

소재

접착 시트

중심 라인

중심 라인
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각인

헤드 캡을 사용하여 각인을 하면 소재 장착이 완료됩니다.   P.66 "각인 시작"으로 이동합니다.
헤드 캡을 사용하지 않는 경우 Step 3으로 이동하십시오.

일반적으로 헤드 캡을 사용하는 것이 좋습니다.

• 헤드 캡을 사용하면 기기가 소재의 표면 높이를 자동으로 감지하여 헤드 위치를 설정합니다.
곡면에도 각인이 가능합니다.(감지할 수 있는 높이에 상한이 있습니다.)

 P.47 "곡면 각인 시 소재의 조건"

• 헤드 캡이 없는 각인은 각인 표면이 수평으로 배치된 소재로 제한됩니다.

3. 헤드 높이 고정(헤드 캡을 사용하지 않은 경우)

A 헤드 캡이 부착된 상태에서 전원/이동 버튼을 누릅니다.

헤드는 헤드 캡의 끝이 소재 표면에 안착하는 위치에서 이동 및 정지합니다.

IMPORTANT

헤드 캡을 사용하지 않는 경우 이 때 헤드 캡을 부착하십시오.  헤드 캡 높이를 올바르게 
설정하지 않으면 원하는 각인 결과를 얻지 못할 수 있습니다.  헤드도 손상되거나 소재가 
긁힐 수 있습니다.

B 헤드의 스토퍼를 풉니다.
노브를 한 번 돌립니다.

푸는방향
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C 스토퍼를 고정하십시오.
① 스토퍼를 바닥으로 내립니다.
② 스토퍼를 고정합니다.
손잡이의 중심을 바로 아래 삼각형의 상단에 맞춥니다.

노브의 중심은 삼각형
표시의 상단 바로 위에 
위치해야 합니다.

D 전원/이동 버튼을 누릅니다.
헤드가 왼쪽 뒤쪽으로 움직입니다.

E 헤드 캡을 분리합니다. 

헤드를 지지합니다.

헤드 캡
헤드 캡의 돌출된 가장자리에   
잡고 빼면 쉽게 제거됩니다.
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각인 시작

경고 작동 중에는 기기의 움직이는 부분에 손과 몸을 가까이 하지 마십시오.
손과 기타 신체 부위가 기기에 끼어 부상을 입을 수 있습니다.

"각인 데이터 생성" 및 "소재 장착"을 완료한 후 각인이 시작됩니다.
 P.48 "각인 데이터 생성", P.42 "소재 준비"

절차

A 를 클릭합니다.
[인쇄] 대화 상자가 나타납니다.

B 아래 기본 설정을 지정하고 확인합니다.

Printer name Roland MPX-95

Material
소재의 구성을 선택하고 각인 품질에 대한 우선 순위(품질 또는 속
도 우선)를 지정합니다.  새로운 각인 데이터를 생성할 때 선택한 내
용이 소재 설정에 반영됩니다.

Print Range

주로 가변 각인에 이 옵션을 사용합니다.(일반적으로 "All"이 선택됩
니다.)  레코드*가 인쇄되도록 제한하려면 인쇄할 레코드(페이지)를 
지정하십시오.  예를 들어 2~5번째 레코드만 인쇄하려면 [page]를 
선택하고 "2" 페이지에서 "5" 페이지까지 지정합니다.

Copies
여러 위치에서 동일한 소재를 각인하는 경우 여러 사본을 지정합니
다.  예를 들어, 소재의 앞면과 뒷면을 인쇄하려면 복사 매수로 
"2"를 지정하십시오.

*레코드 : 가변 각인용 데이터에 포함된 개별 데이터를 말합니다.
 P.90 "가변 각인 데이터 생성"
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C [OK]를 클릭합니다.
각인이 시작됩니다.

MEMO :  여 러  사 본  또 는  레 코 드  각 인

인쇄가 시작되면 그림과 같은 메시지가 나타납니다.  각인이 완료될 때까지 기다린 후 다음 단계로 
넘어갑니다.

D 각인이 완료되면 소재를 교체하거나 방향을 변경하십시오.
 P.60 "소재 장착"

IMPORTANT

소재를 교체할 때마다 레이저 포인터 버튼을 사용하여 위치를 정렬해야 합니다.

E [OK]를 클릭합니다.
다음 페이지의 인쇄가 시작됩니다.

표시된 레코드만 가변 각인 :

         를 클릭합니다. 
[인쇄] 대화 상자가 나타납니다.
METAZAStudio에 표시되는 레코드의 번호(페이지 번호)는 [Print Range] 아래의 페이지
로 지정됩니다.  필요에 따라 [Material] 및 [Copies]를 지정하고 [OK]를 클릭하여 각인을 
시작합니다.
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각인 작업 중지
전원/이동 버튼을 1초 이상 길게 누릅니다.
전송된 각인 데이터가 삭제되는 동안 표시등이 천천히 깜박입니다.  표시등이 꺼지고 전원이 
꺼집니다.

MEMO

각인이 일시 중지되면 헤드가 동일한 위치에 유지됩니다.  다음에 전원을 켤 때 헤드가 왼쪽 뒤쪽으로 
이동합니다.

각인 작업 중지
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각 인  작 업  중 지

각인 대기열에서 데이터 삭제

절차

A 프린터 아이콘을 표시합니다.

Windows 10
① 컴퓨터에서 [시작] 메뉴를 클릭합니다.
② [Windows 시스템]을 클릭한 후 [제어판]을 클릭합니다.
③ [장치 및 프린터 보기]를 클릭합니다.

Windows 8.1
① 컴퓨터에서 [시작] 메뉴를 마우스 오른쪽 버튼으로 클릭합니다.
② [제어판]을 클릭합니다.
③ [장치 및 프린터]를 클릭합니다.

B [Roland MPX-95] 아이콘을 더블 클릭합니다.

C [프린터] 메뉴에서 [모든 문서 취소](또는 [문서 인쇄 삭제])를 클릭합니다.

D 그림과 같은 메시지가 나타나면 [Yes]를 클릭합니다.
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이미지 처리

이미지의 필요한 부분만 유지(트리밍)

METAZAStudio는 원본 이미지를 잘라 불필요한 부분을 제거하고 필요한 부분만 유지할 수 있습
니다.  이 작업을 "trimming(트리밍)"이라고 합니다.

절차

A 이미지를 가져옵니다.
 P.56 "Step 2: 이미지 불러오기"

B 이미지를 선택합니다.

① 를 클릭합니다.
② 이미지를 클릭합니다.

이미지 주위에 8개의 트리밍 막대가 나타납니다.

C Trimming(트리밍)
트리밍 막대를 끌어 유지하려는 영역을 트리밍합니다.

트리밍 포인터

고급 설정 구성 / 이미지 처리
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고급 설정 구성 / 이미지 처리

이미지의 위치, 크기 또는 각도 조정

A 를 클릭합니다.

B 이미지의 위치를 조정합니다.
① 이미지를 클릭합니다.

(■) 이미지의 네 모서리에 나타납니다.
② 이미지를 드래그하여 위치를 조정합니다.

2

각
인

71



고 급  설 정  구 성  /  이 미 지  처 리

C 이미지의 크기를 조정합니다.
① 이미지를 클릭합니다.

(■) 이미지의 네 모서리에 나타납니다.
② 이미지의 네 모서리에 있는 핸들을 드래그하여 크기를 조정합니다.

핸들

D 이미지의 각도를 조정합니다.
① 이미지의 네 모서리에 핸들이 있는 상태에서 이미지를 두 번 클릭합니다.

네 모서리의 핸들 모양이 (●)로 바뀝니다.
② 포인터와 핸들을 정렬합니다.

모양이 회전 포인터로 바뀝니다.
③ 드래그하여 이미지의 각도를 조정합니다.
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고 급  설 정  구 성  /  이 미 지  처 리

MEMO

• 키보드의 SHIFT 키를 누른 상태에서 드래그하면 각도가 한 번에 45도씩 변경됩니다.  이 방
법을 사용하면 정확하게 90도 회전을 수행하려는 경우와 같이 편리할 수 있습니다.

• 각도가 변경된 이미지는 트리밍할 수 없습니다.  트리밍을 수행하려면 먼저 이미지를 원래
각도로 되돌립니다.

이미지를 프레임에 담기

이미지 주위에 frame(프레임)을 배치하여 각인 데이터의 배열을 변경할 수 있습니다.  
METAZAStudio의 "library(라이브러리)"에 등록된 frame(프레임)을 사용합니다.  library(라이브러
리)에는 미리 등록된 여러 frame(프레임)이 포함되어 있으며 새 frame(프레임)을 등록할 수 있습니
다.

 METAZAStudio 온라인 도움말("Hints and Tips">"Making Use of Library")

절차

A 를 클릭합니다.
[Library] 창이 나타납니다.

2

각
인

73



고 급  설 정  구 성  /  이 미 지  처 리

B frame(프레임)을 삽입합니다.
① [Group]에서 [Frame]을 선택합니다.
② [Icon]을 선택합니다.
③ [04] flame(프레임)을 클릭합니다.
④ 를 클릭합니다.

프레임이 창에 삽입됩니다.

C 프레임의 크기와 위치를 조정합니다.

프레임의 크기가 소재의 크기보다 클 경우 결과는 그림과 같이 됩니다.  조정 방법은 이미지의 
위치 및 크기 조정 방법과 동일합니다.

 P.71 "이미지의 위치, 크기 또는 각도 조정"

핸들
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텍스트 레이아웃을 위한 팁과 요령

텍스트의 위치, 크기 또는 각도 조정

이미지와 마찬가지로 배치된 텍스트의 위치, 크기, 각도를 변경할 수 있습니다.

절차

A 텍스트를 입력합니다.
 P.58 "Step 3: 텍스트 입력"

B 텍스트 위치를 조정합니다.
① 를 클릭합니다.

② 배치된 텍스트를 클릭합니다.
텍스트 주위에 8개의 핸들이 나타납니다.

③ 텍스트를 드래그하여 위치를 조정합니다.

C 프레임의 크기를 조정합니다.
핸들을 끌어 크기를 조정합니다.
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고 급  설 정  구 성  /  이 미 지  처 리

D 텍스트의 각도를 조정합니다.
① 텍스트를 클릭하고 네 모서리의 핸들 모양이 [●]로 바뀔 때까지 누르고 있습니다.
② 포인터와 핸들을 정렬합니다.

모양이 회전 포인터로 바뀝니다.
③ 드래그하여 텍스트의 각도를 변경합니다.

MEMO

키보드의 SHIFT 키를 누른 상태에서 드래그하면 각도가 한 번에 45도씩 변경됩니다.  이 방법을 사
용하면 정확하게 90도 회전을 수행하려는 경우와 같이 편리할 수 있습니다.

팬 레이아웃에 텍스트 정렬

A 텍스트를 입력합니다.
 P.58 "Step 3: 텍스트 입력"

B 를 클릭합니다.
[Properties] 대화 상자가 나타납니다.
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C 텍스트 배치를 설정합니다.
① Format 탭을 클릭합니다.
② [Align with Curve] 체크박스를 선택합니다.
③ [OK]를 클릭합니다.
텍스트 레이아웃이 부채꼴 모양으로 변경됩니다.
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모양을 따라 텍스트 레이아웃

그리기 도구를 사용하여 만든 모양을 따라 텍스트를 배치합니다.

절차

A 모양을 만듭니다.
① 그리기 도구를 클릭합니다.

이 예에서는        을 사용합니다.
② 편집 창에서 소재에 모양을 만듭니다.
 METAZAStudio 온라인 도움말("Commands"-"Toolbar buttons")

그리기 도구

B 를 클릭합니다.
생성한 도형의 윤곽선 근처에 포인터를 놓고 포인터 아래에       이 나타나면 클릭합니다.
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C 텍스트를 입력합니다.
 P.58 "Step 3: 텍스트 입력"
모양을 따라 텍스트가 배치됩니다.

IMPORTANT

통합 폴리라인의 레이아웃은 불가능합니다.
 METAZAStudio 온라인 도움말("Commands">"[Object] menu">"Convert to Polyline", "Integrate Polyline")

텍스트 채우기

텍스트를 채우는 방법에는 [Fill]과 [Island Fill]의 두 가지가 있습니다.  원하는 방법을 선택하십시오.

Fill
텍스트가 공백 없이 채워집니다.

Island Fill
인접한 채우기 선 사이의 간격을 지정할 
수 있습니다.

A 텍스트를 입력합니다.
 P.58 "Step 3: 텍스트 입력"

B 를 클릭합니다.
[Properties] 대화 상자가 나타납니다.
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C 채우기 설정 구성
① [Fill and Contour] 탭을 클릭합니다.
② [Fill] 체크박스를 선택합니다.
③ [Fill] 또는 [Island Fill]을 선택합니다.
[Island Fill]을 선택하면 pitch(피치)*도 입력해야 합니다.
*Pitch(피치) : 인접한 채우기 라인 사이의 간격
④ [OK]를 클릭합니다.
텍스트가 채워집니다.

IMPORTANT

알루미늄 등의 소재에 선이 많은(Island Fill 등) 각인을 하면 소재 표면의 요철이 많아져 헤드 캡의 
마모가 빨라집니다.  헤드 캡의 상태를 주기적으로 확인하여 필요할 때마다 교체하도록 합니다.

 P.113 "헤드 캡 교체"

Stroke(스트로크)  문자 글꼴 생성/편집

스트로크  문자와 SFEdit2 에 대하여

스트로크  문자는 무엇입니까?
모든 스트로크 문자는 폴리라인과 선으로 구성됩니다.

SFEdit2는 무엇입니까?
SFEdit2는 스트로크 문자 글꼴을 만들고 편집하는 프로그램입니다.  모든 스트로크 문자는 폴리라
인과 선으로 구성되어 있으므로 기준점을 추가 또는 삭제하고 선분을 추가할 수 있습니다.  
METAZAStudio에서는 SFEdit2를 사용하여 만들고 편집한 스트로크 문자 글꼴을 사용할 수 있습니
다.
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SFEdit2 창

No. 이름 기능 개요

① Menu bar
SFEdit2에 대한 다양한 명령을 실행합니다.

 SFEdit2 도움말("Commands")

② Toolbar
Toolbar에는 [Open...] 및 [Save]와 같은 SFEdit2 명령을 실행하기 
위한 버튼이 있습니다.

 SFEdit2 도움말("Commands"-"Toolbar buttons")

③ Status Bar 포인터를 Toolbar 버튼으로 이동하거나 메뉴 명령을 가리키면 버튼 
또는 명령에 대한 간략한 설명이 표시됩니다.

④ Character List 모든 스트로크 문자 목록이 표시됩니다.  스트로크 문자를 편집하
려면 클릭합니다.

⑤ Base line
문자열을 가로로 정렬하기 위한 기준선입니다.  글자를 가로로 쓸 
때 인접 문자의 기준선은 요철이 없도록 가로선을 따라 일렬로 정렬
됩니다.

⑥ Text box
텍스트를 묶는 상자입니다.  상자의 크기는 기본 글꼴의 종류와 문자
에 따라 다릅니다.  일반적으로 상자 안에 맞도록 텍스트를 만들어야 
합니다.

⑦ Base font text 이것은 스트로크 문자를 편집하기 위한 대략적인 초안으로 표시됩니
다.  기본 글꼴은 스트로크 문자의 디자인 기반 역할을 합니다.

⑧ Stroke Characters

모든 스트로크 문자는 폴리라인과 선으로 구성됩니다.  모든 스트로크 
문자는 기준점 추가 또는 삭제, 선분 추가 등을 통해 편집할 수 있습
니다.

 SFEdit2 도움말("Operation Procedures">"Step 2: Edit the 
shape of character")  
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스트로크  문자 글꼴 만들기

스트로크 문자 글꼴을 만들고 저장하는 방법은 아래에 설명되어 있습니다.

절차

A  METAZAStudio를 시작합니다.
 P.48 "METAZAStudio 시작하기", P.28 "소프트웨어 시작 방법"

B [Edit]→[Stroke Font]→[Run SFEdit2…]를 클릭합니다.
SFEdit2가 시작됩니다.

C [File] → [New…]를 클릭합니다.
[Select Base Font] 대화 상자가 나타납니다.

D 스트로크 문자를 만듭니다.

① 생성할 스트로크 문자 글꼴의 기준으로 사용할 글꼴을 선택합니다.
② [OK]를 클릭합니다.
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스트로크 문자 글꼴이 자동으로 생성됩니다.

E 클릭합니다.

[Save] 대화 상자가 나타납니다.

F 생성된 스트로크 문자 글꼴의 이름을 입력하고 저장합니다.

① 생성된 스트로크 문자의 이름을 입력합니다.
기본 글꼴 이름을 기반으로 이름을 지정하면 나중에 새 이름을 쉽게 식별할 수 있습니다.

예를 들어 "MS P Gothic_SF"가 입력됩니다.
② [OK]를 클릭합니다.

생성된 스트로크 문자 글꼴이 저장됩니다.

G 를 클릭합니다.
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입력한 문자를 스트로크  문자 글꼴에서 스트로크  문자로 변경

다음 작업 중 하나가 완료되었는지 확인합니다.

SFEdit2를 설치하기 전에 스트로크 문자 글꼴을 만드십시오.
설치하는 동안 그림과 같은 창이 나타납니다.  설치 시 스트로크 문자 글꼴을 생성하지 않았다면 
SFEdit2를 다시 설치하고 스트로크 문자 글꼴을 생성하십시오.
 P.24 "드라이버 및 소프트웨어 설치", P.130 "소프트웨어를 별도로 설치"

새 스트로크 문자 글꼴을 만듭니다.
 P.82 "스트로크 문자 글꼴 만들기"

절차

A METAZAStudio에 텍스트를 입력합니다.
 P.58 "Step 3: 텍스트 입력"

B 를 클릭합니다.
[Properties] 대화 상자가 나타납니다.
입력한 텍스트가 포함된 텍스트 상자를 선택하지 않으면      를 선택할 수 없습니다.  텍스트 
상자를 선택해야 합니다.
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C 스트로크 문자 글꼴을 선택합니다.
① [Format] 탭을 클릭합니다.
② [Stroke]를 선택합니다.
[Font]에 대한 옵션은 스트로크 문자로 제한됩니다.
③ 스트로크 문자 글꼴을 선택합니다.
④ [OK]를 클릭합니다.

입력된 문자는 스트로크 문자로 변경됩니다.  스트로크 문자는 ③에서 선택한 스트로크 
문자 글꼴을 사용합니다.
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스트로크 문자 편집

절차

A 입력 문자를 스트로크 문자로 변경합니다.
 P.84 "입력한 문자를 스트로크 문자 글꼴에서 스트로크 문자로 변경"

B 스트로크 문자 편집을 시작합니다.

① 을 클릭합니다.
② 편집할 스트로크 문자를 클릭합니다.
스트로크 문자 주위에 6개의 포인터가 나타납니다.
③ [Edit] → [Stroke Font] → [Edit Stroke…]를 클릭합니다.

SFEdit2 시작됩니다.

C 문자 목록에서 편집할 스트로크 문자를 클릭합니다.
편집하려는 스트로크 문자가 가상 바디에 표시되고 스트로크 문자를 편집할 수 있게 됩니다.  

스트로크 문자의 위치와 모양을 변경합니다.
 SFEdit2 도움말("폴리라인 편집")

Character List
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D SFEdit2를 닫습니다.

① 를 클릭합니다.
편집 내용을 선택한 스트로크 문자 글꼴로 덮어씁니다.
② 를 클릭합니다.

SFEdit2가 닫힙니다.

편집 내용이 스트로크 문자에 반영됩니다.
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이미지의 완성된 결과 확인 및 조정

미리보기 창에서 완료된 결과 확인하기

미리보기 창이 나타납니다.
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미리보기 창에서 완성된 결과 조정하기

미리보기 창에서 밝기, 대비, 감마 보정을 조정할 수 있습니다.  밝고 어두운 영역이 명확한 이미지 
일수록 인쇄결과가 좋습니다.

No. 이 름 기 능  개 요

① Brightness
전체 밝기를 조정합니다.  값을 너무 크게 하면 균형이 깨질 수 있으므로 필
요한 절대 최소값으로 조정하는 것이 좋습니다.

② Contrast
이것은 주로 하이라이트(가장 밝은 영역)와 쉐도우(가장 어두운 영
역)를 조정합니다.  명암의 균형이 잘 잡힌 결과물을 얻고 싶을 때 
사용하면 효과적입니다.

③ Gamma

이것은 주로 밝은 영역과 어두운 영역 사이의 중간 밝기 톤의 밝기를 
조정합니다.  전체 밝기 조절에 효과적입니다.
어둡고 밝은 영역은 다음 그림과 같이 각인됩니다.  어두운 색 영역은 
타격하지 않고 밝은 색 영역은 세게 타격합니다.

어두운 영역

밝은 영역

조정 전후의 각인 결과는 아래와 같습니다.

조정 전 조정 후

감마를 0.4로 조정합니다.
얼굴의 밝기가 감소하고 표정이 선명해집니다.
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가변 각인 데이터 생성
인쇄 데이터의 일부를 변경한 후 각 소재에 다른 개체를 각인하는 것을 "가변 각인"이라고 합니다.  
가변 각인을 수행할 때 새 소재를 장착할 때마다 새 데이터를 생성할 필요가 없습니다.  중단 없이 다
른 데이터를 계속 인쇄할 수 있습니다.

IMPORTANT

다양한 데이터를 사용한 연속 각인은 동일한 구성과 크기의 소재로만 수행할 수 있습니다.

가변 각인을 수행하려면 CSV 파일이 필요합니다.

데이터베이스 파일을 사용하여 CSV 파일을 생성할 수 있습니다.  CSV 파일 생성에 대한 정보는 
데이터베이스 관리자에게 문의하십시오.

1. "변수 필드" 만들기

MEMO :  가 변  필 드 란 ?

가변 필드는 텍스트를 배치할 수 있는 프레임입니다.  가변 각인을 사용하면 각인 중에 변수 필드 내의 
데이터가 다른 데이터로 대체됩니다.

A METAZAStudio를 시작합니다.
 P.28 "소프트웨어 시작 방법"

표시되는 [Select Material] 대화상자에서 소재를 선택합니다.
METAZAStudio가 실행 중이면       을 클릭합니다.

[Select Material] 대화 상자가 나타납니다.
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B [Select Material] 대화 상자에서 소재를 선택합니다.

[Use printer driver settings] 확인란의 선택을 취소하여 소재 유형을 선택합니다.  목록에 
포함되지 않은 소재를 사용하려면 소재를 등록할 수 있습니다.
 P.102 "구성 등록 및 타격력 조정"

METAZA Driver 2 설정을 변경하지 않고 사용하는 경우 [Use printer driver settings] 
확인란을 선택합니다.

C  [OK]를 클릭합니다.

D 프레임 삽입 아이콘을 클릭합니다.

    를 클릭하고      를 클릭합니다.
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E METAZAStudio의 작업 영역*에서 마우스를 대각선 아래로 드래그합니다.

텍스트를 배치할 수 있는 변수 필드가 생성됩니다. 
* 작업 영역 = 화면의 검은색 영역

작업 영역 

F [Object] > [Move to Center]를 클릭합니다.
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가변 필드의 중심이 작업 영역의 중심으로 이동합니다.

IMPORTANT : 이 작업은 실제 각인 위치와 관련되어 중요합니다.

기기에서 각인의 중심점은 각인 기준점으로 정의됩니다.  METAZAStudio의 "작업 영역의 중심"은 각인 
작업의 기준점과 일치합니다.  따라서 "가변 영역의 중심"을 작업 영역의 중심과 일치시킨다는 것은 "가
변 영역의 중심"을 "실제 각인 작업의 기준점"과 일치시키는 것을 의미합니다.

가변필드의 중심을 '각인 작업의 기준점'에 맞추지 않고도 각인할 수 있지만, 이 점들을 서로 
일치시키면 각인할 텍스트와 이미지를 원하는 위치에 쉽게 배치할 수 있습니다.

G 를 클릭합니다.
[Properties] 대화 상자가 나타납니다.

변수 필드를 선택하지 않으면  를 클릭할 수 없습니다.  를 클릭할 수 없으면 
 를 클릭하고 변수 필드를 클릭(select)합니다.
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H 변수 필드의 크기를 포함한 속성에 대한 설정을 구성합니다.
각 설정에 대한 자세한 내용은 METAZAStudio 도움말("Commands"-"[Object] 메

뉴"-"Properties"-"[Properties]대화 상자")을 참조하십시오.
 P.28 "소프트웨어 도움말을 표시하는 방법"

설정을 구성한 후 [OK]를 클릭합니다.

2. 변수 필드 안에 텍스트 배치

A [Load CSV File]을 클릭합니다.
[Open...] 대화 상자가 나타납니다.
"Variable Printing" 창이 표시되지 않으면      을 클릭합니다.

B CSV 파일을 지정하고 [Open]을 클릭합니다.

지정된 CSV 파일을 METAZAStudio로 가져옵니다.
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C 가져온 CSV 파일의 열 제목을 변수 필드로 끌어다 놓습니다.

변수 필드에 텍스트가 표시됩니다.

     를 클릭하면 각 기호를 차례로 표시할 수 있습니다.  변수 필드의 크기나 위치를 
변경하려면 [Properties] 대화 상자를 열고(     를 클릭) 설정을 변경합니다.
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곡면에 각인
헤드 캡을 사용하여 곡면을 각인할 수 있습니다.  이 섹션에서는 아래에 표시된 것과 같은 반원통 
소재를 예로 방법을 설명합니다.

50mm
(2.0in) 

10mm
(0.4in)지름(φ)=20mm(0.8in)

1. 인쇄 영역 설정

먼저 소재의 각인 영역에 대한 설정을 구성합니다.  곡면 각인 시 소재의 전면(평면 소재와 마찬가지
로) 각인은 불가능합니다.  이러한 이유로 METAZAStudio 편집 창은 소재 대신 각인 영역을 표시합
니다.  METAZA Driver 2 설정 창에서 입력한 소재의 직경 값에 따라 각인 영역이 결정됩니다.
기기가 각인할 수 있는 곡면이 있는 소재의 조건에 대한 자세한 내용은 아래 표시된 페이지를 참조
하십시오.

 P.47 "곡면 각인 시 소재의 조건"

A [File]→[Preferences]를 클릭합니다.

[Preferences] 대화 상자가 나타납니다.
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B 여백을 설정합니다.
① "Margin"을 "0mm"(0in)로 설정합니다.
② [OK]를 클릭합니다.

MEMO

곡면을 각인할 때 인쇄할 수 있는 영역이 제한됩니다.  충분한 인쇄 영역을 확보하려면 여백을 
0mm(0in)로 설정하십시오.

C [File]→[Set up the printer]를 클릭합니다.
[Print Setup] 대화 상자가 나타납니다.
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D 프린터의 [Properties] 대화 상자가 나타납니다.

① 프린터 이름으로 [Roland MPX-95]가 선택되어 있는지 확인합니다.
② [Properties]을 클릭합니다.

E 소재의 크기값을 입력합니다.

① [Material] 탭을 클릭합니다.
② 직경을 입력합니다.
이 예에서는 20mm(0.8in)로 설정합니다.
③ [Direction]을 선택합니다.
센터 바이스 방향으로 방향을 맞춥니다.

: 수직 : 수평

이 예에서는 (수직)을 선택합니다.
④ [Enter]를 클릭합니다.
[Work Size]에서 [Width] 값이 자동으로 설정됩니다.  [Length]의 경우 이 예에서는
50mm(2.0in)로 설정합니다.
⑤ [OK]를 클릭합니다.
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F	Click [OK].

이것으로 각인 영역 설정의 구성을 마칩니다.

2. 세로 소재에 가로로 글씨 쓰기

각인 영역이 결정되면 해당 영역에 이미지와 텍스트를 배치합니다.  이 섹션에서는 세로 소재에 가
로로 문자를 입력하는 방법에 대해 설명합니다.

A 첫 글자를 입력합니다.

① 각인할 텍스트를 입력하고 레이아웃을 조정합니다.
② 텍스트 크기를 원하는 크기로 변경합니다.
텍스트는 각인 영역에 맞아야 합니다.

B 입력한 문자를 회전시켜 세로로 만듭니다.
 P.75 "텍스트의 위치, 크기 또는 각도 조정"
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C 텍스트 입력용 커서가 나타납니다.

① 를 클릭합니다.
② 키보드의 <→> 키(왼쪽 화살표 키)를 누릅니다.

결과는 그림과 같이 됩니다.

D 나머지 텍스트를 입력하고 원하는 위치로 텍스트를 이동합니다.
 P.71 "이미지의 위치, 크기 또는 각도 조정"
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다양한 소재 등록
METAZAStudio에는 4가지 형태의 사전 등록된 소재가 포함되어 있습니다.  METAZAStudio에 등록
되지 않은 소재를 각인하려면 먼저 신규 소재로 등록하십시오.  이는 각인 영역이 제한되는 것을 방
지하고 소재의 가장자리에 부딪혀 헤드의 마킹 핀이 손상되는 것을 방지합니다.
소재 등록에는 다음 세 가지 방법이 있습니다.  절차에 대한 자세한 내용은 METAZAStudio의 온라
인 도움말을 참조하십시오.

 P.28 "소프트웨어 도움말을 표시하는 방법"
 METAZAStudio 온라인 도움말("Hint and Tips">"Registering Favorite Material")

비트맵 이미지 가져오기

소재와 동일한 크기의 이미지가 있는 경우 다음 조건에서 이미지를 가져올 수 있습니다.

• 파일 형식 : BMP(비트맵) 또는 JPEG여야 합니다.
• 색상 : 흑백
• 소재에 해당하는 부분은 검은색으로 채워야 합니다.

스캐너로 소재 스캔하기

소재의 모양이 같은 이미지가 없거나 소재의 모양이 복잡한 경우 시중에서 판매하는 스캐너로 소재를 
스캔하여 생성된 이미지를 가져올 수 있습니다.  이에 대한 요건은 다음과 같습니다.

• 스캐너 : TWAIN_32를 지원하는 스캐너.
• 색상 : 흑백(소재에 해당하는 부분은 검정색으로 채워져야 함)

소재의 모양 그리기

소재가 정사각형, 원형 또는 기타 간단한 모양인 경우 그리기 도구를 단독으로 또는 조합하여 소재
의 모양을 직접 그려서 등록할 수 있습니다.

2

각
인

101



고 급  설 정  구 성  /  이 미 지  처 리

구성 등록 및 타격력 조정
이 기기를 사용하면 사용되는 소재의 구성에 적합한 타격력을 사용하여 각인하면 훨씬 더 높은 품질
의 각인 결과를 얻을 수 있습니다.  기기용 METAZA Driver 2에는 여러 소재와 적절한 타격력에 대
한 설정이 미리 구성되어 있지만 소재와 최적의 타격력을 직접 등록할 수도 있습니다.  더 나은 각인
결과를 얻기 위해 나중에 직접 등록한 구성의 타격력을 조정할 수도 있습니다.

절차

A METAZA Driver 2 인쇄 기본 설정 화면을 표시합니다.
 P.26 "METAZA Driver 2 인쇄 기본 설정 화면을 여는 방법"

B 각인 모드를 선택합니다.
① [Image Correction] 탭을 클릭합니다.
② [Material]는 사용자 지정 소재를 선택합니다(setting a~d).
③ 각인 모드를 선택합니다.

Text 명확한 윤곽으로 텍스트 및 기타 이미지를 각인하려는 경우

Photo 사진 및 기타 이미지를 그라데이션으로 각인하려는 경우

High Resolution 작은 글씨와 작은 문양을 또렷하게 표현하고 싶을 때

Other 이미지의 해상도 설정 및 기타 설정을 구성하려는 경우

 METAZA Driver 2 온라인 도움말 ("[Correction] tab")

④ [Details]를 클릭합니다.

[Details] 대화 상자가 나타납니다.
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C 자세한 각인 모드 설정을 구성합니다.
① 등록하려는 구성의 이름을 입력합니다.
② 속도와 타격력을 입력합니다.
각인 결과는 소재의 경도에 따라 다릅니다.  소재에 맞게 조정하십시오.

 METAZA Driver 2 온라인 도움말([Correction] tab > [Details] 대화상자)

Impact--MIN
이미지에 대한 각인 타격력의 최소값을 설정할 수 있습니다.  이미지의 
어두운 영역이 칠해지지 않은 경우 값을 높입니다.  이미지의 어두운 부
분이 희끄무레하거나 전체적인 타격이 너무 강한 경우 값을 낮추십시오.

Impact--MAX

이미지에 대한 각인 타격력의 최대값을 설정할 수 있습니다.  이미지의 
밝은 부분을 너무 약한 힘으로 치거나 전체적인 타격이 너무 약한 경우 
값을 높입니다.  이미지의 밝은 부분의 타격이 너무 강한 경우 값을 낮추
십시오.

Vector Impact 라인에 대한 각인 타격력의 최대값을 설정할 수 있습니다.

③ [Advance]를 선택합니다.
[Advance]는 Step B의 ③에서 [Other]를 선택한 경우에만 사용할 수 있습니다.
 METAZA Driver 2 온라인 도움말([Correction] tab > [Details] 대화상자)

Output Resolution 인치당 도트 수를 지정할 수 있습니다.  포인트 수가 많을수록 이미지가 
더 정확해집니다.

Drafting "ON"을 선택하면 한 도트 단위로 이미지 정보를 건너뛸 수 있습니다.

④ [OK]를 클릭합니다.

[Details] 대화 상자가 닫힙니다.
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드라이버 기본 설정 변경

절차

A 프린터 아이콘을 표시합니다.

Windows 10
① 컴퓨터에서 [시작] 메뉴를 클릭합니다.
② [Windows 시스템]을 클릭한 후 [제어판]을 클릭합니다.
③ [장치 및 프린터 보기]를 클릭합니다.

Windows 8.1
① 컴퓨터에서 [시작] 메뉴를 마우스 오른쪽 버튼으로 클릭합니다.
② [제어판]을 클릭합니다.
③ [장치 및 프린터]를 클릭합니다.

B [Roland MPX-95] 아이콘을 마우스 오른쪽 버튼으로 클릭하고 [인쇄 기본 설정]을 클릭합니다.
METAZA Driver 2의 [Details] 창이 나타납니다.  필요에 맞게 설정을 변경하십시오.

C 설정을 구성한 후 [OK]를 클릭합니다.
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설명

METAZA Driver 2를 사용하면 소재의 크기와 표시에 사용되는 단위를 비롯한 다양한 항목에 대한 
기본 설정을 구성할 수 있습니다.  앞에서 설명한 방법으로 설정을 하면 기본 설정이 계속 적용됩니
다.
METAZAStudio에서 이러한 설정을 변경할 수 있지만([File] 메뉴에서 [Print Setup]→[Properties]

를 클릭하여 Step C에 표시된 [인쇄 기본 설정]을 표시하지만 METAZAStudio를 다시 시작하면 변
경 사항이 사라집니다.

METAZAStudio에서 사용할 수 있는 기타 작업
METAZAStudio에는 다양한 기타 기능이 포함되어 있습니다.
조작 방법에 대한 정보는 METAZAStudio의 온라인 도움말을 참조하십시오.

 P.28 "소프트웨어 도움말을 표시하는 방법"

Dr. Engrave에 대하여

Dr. Engrave란?

Dr. Engrave는 판재용 각인 소프트웨어입니다.
이 소프트웨어는 쉼표나 탭으로 구분된 데이터를 포함하는 텍스트 파일을 문자 필드로 가져올 수 있
습니다.  텍스트 쓰기 기능이 있는 스프레드시트 소프트웨어 및 데이터베이스 소프트웨어로 만든 파
일을 사용할 수 있습니다.  자세한 내용은 Dr. Engrave 도움말을 참조하세요.

 P.28 "소프트웨어 도움말을 표시하는 방법"

Dr. Engrave 사용 시 주의 사항

• 소재 크기(또는 각인 영역 크기) 설정은 METAZA Driver 설정 창에서 해야 합니다.
 P.104 "드라이버 기본 설정 변경"

• 소재의 중심(또는 각인 영역)이 테이블(또는 센터 바이스)의 중앙에 오도록 설정합니다.
 P.60 "소재 장착"
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두꺼운(높은) 소재에 각인
70mm(2.8인치)보다 두꺼운 소재를 각인하려면 베이스 유닛을 제거하십시오.

 P.42 "소재 준비"

IMPORTANT

베이스 유닛을 사용하는 경우에 비해 각인 위치 정렬 정확도가 낮아집니다.  본 작업을 하기 전에 
테스트 각인을 수행하고 위치를 미세 조정합니다.

절차

A 베이스 유닛이 기기에 장착되어 있으면 제거하십시오.
 P.37 "베이스 플레이트 설치/제거

B 각인할 표면이 각인 가능한 영역에 맞도록 소재를 장착합니다.
소재를 고정하고 인쇄물 높이를 조정합니다.

 P.42 "소재 준비"

C 전원 켜기
 P.32 "전원 켜기"

D 전원/이동 버튼을 누릅니다.
소재 높이를 감지할 수 있는 위치로 헤드를 내립니다.

IMPORTANT

소재 높이가 조건에 맞지 않을 경우 오류가 발생하고 [전원/이동] 버튼이 깜박입니다.  높이에 적합한 
방식으로 소재를 다시 장착합니다.
 P.42 "소재 준비",  P.60 "소재 장착",  P.118 "소재가 소재 두께(높이)에 맞게 설정되었습니까?"

E 전원/이동 버튼을 다시 누릅니다.
헤드가 왼쪽 뒤쪽으로 움직입니다.

F 레이저 포인터 버튼을 누릅니다.
레이저 포인터가 조사됩니다.  레이저 포인터가 소재에 각인될 영역의 중앙을 가리키도록 
소재의 위치를 조정합니다.

계속하려면 P.66 "각인 시작" 및 각인을 참조하십시오.
위치를 확인하기 위해 테스트 각인을 수행하는 것이 좋습니다.
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일일 유지보수 시 주의 사항

	

	

	

	

휘발유, 알코올, 시너, 기타 가연성 물질을 절대 사용하지 마십시오. 
화재의 원인이 됩니다.

수리, 부품 교체 및 이와 유사한 작업 중에는 사용 설명서에 기재되지 않은 
작업을 수행하지 마십시오.
Roland DG Corporation 공인 대리점에 문의하십시오.

모든 전원 스위치를 끈 상태에서 이 작업을 수행하십시오.
이 지침을 준수하지 않으면 기기가 갑자기 움직여 부상을 입을 수 있습니다.

각인이 끝난 직후에는 절대로 헤드를 만지지 마십시오. 
화상을 입을 수 있습니다.

• 본 기기는 정밀기기로 먼지와 오염에 약합니다.  매일 청소를 수행하십시오.
• 신나, 벤젠, 알코올 등의 용제는 절대 사용하지 마십시오.
• 기기에 기름을 바르거나 윤활유를 바르지 마십시오.
• 절대 기기에 실리콘 물질(기름, 그리스, 스프레이 등)을 바르지 마십시오.  스위치 접촉 불량의

원인이 됩니다.

일일 유지보수
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일 일  유 지 보 수

기기와 소재 리테이너 청소
• 물에 적신 천을 잘 짜서 사용하시고 가볍게 닦아 주십시오.
• 커버 표면은 쉽게 긁히므로 부드러운 천을 사용하세요.
• 옵션 키트의 소재 리테이너를 사용하는 경우 기기와 동일한 방법으로 그리드 테이블을 청소하십

시오.

접착 시트 청소
접착 시트에 먼지 등이 쌓이면 시트의 접착력이 저하되어 소재를 제자리에 고정하기 어려울 수 있습
니다.  접착력이 저하된 경우 접착 시트를 세척하십시오.

세척 방법

접착 시트를 물에 담그고 표면을 부드럽게 쓰다듬어 시트를 씻으십시오.  접착시트의 더러움이 심한 
경우에는 희석한 중성세제로 세척하세요.  모든 세제를 완전히 제거하기 위해 물로 완전히 헹굽니
다.

IMPORTANT

다음 지침을 반드시 준수하십시오.  그렇지 않으면 접착 시트의 표면이 손상되어 접착력이 저하
될 수 있습니다.

• 수세미나 스폰지로 접착 시트를 문지르지 마십시오.
• 접착 시트를 세척할 때 절대로 늘리거나 구부리지 마십시오.

건조 방법

직사광선을 피해 완전히 말리십시오.

헤드 캡 청소
기기에서 헤드 캡을 분리하고 헤드 캡의 표면과 내부에서 먼지나 이물질을 제거합니다.  헤드 캡에
서 먼지나 이물질을 먼저 제거하지 않고 각인하면 소재가 손상되거나 인쇄 품질에 영향을 줄 수 있
습니다.
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핀의 타격력 조정
MPX-95 Head Manager를 이용하여 핀의 타격력을 조절할 수 있습니다.  핀 조정에는 그림에 표시
된 패턴을 각인하는 작업이 포함됩니다.  제공된 테스트 각인 재료(황동) 또는 너비 60mm(2.4인
치), 길이 60mm(2.4인치) 이상인 소재를 준비해야 합니다.

조정 패턴

절차

A MPX-95 Head Manager를 시작합니다.
 P.28 "소프트웨어 시작 방법"

B 기기의 전원을 켭니다.
 P.32 "전원 켜기"

C [Readjust Pin]을 클릭합니다.

조정
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조 정

[Adjust Pin] 마법사가 나타납니다.
화면의 지시에 따라 핀 조정을 수행하십시오.

IMPORTANT

• 접착 시트와 그리드 테이블을 사용하여 테스트 패턴을 각인할 소재를 장착합니다.

• 헤드 캡을 사용하십시오.
 P.60 "소재 장착"

조정 패턴이 인쇄되지 않으면 아래에 제공된 섹션을 참조하십시오.
 P.120 "각인된 위치가 원하는 위치가 아닌 경우"

D 완료되면         을 클릭합니다. 

창이 닫힙니다.

원점 위치 조정
각인된 텍스트나 이미지가 원하는 위치와 일치하지 않는 위치에 놓이면 기기의 원점이 어긋난 것입
니다.  아래 설명된 방법을 사용하여 원점을 조정합니다.

절차

A MPX-95 Head Manager를 시작합니다. 
 P.28 "소프트웨어 시작 방법"
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조정

B [Adjust Origin]을 클릭합니다.

[Adjust Origin] 마법사가 나타납니다.
화면의 지시에 따라 조정을 수행하십시오.

C 완료되면          을 클릭합니다. 

창이 닫힙니다.

3

유
지

보
수

와
 조

정

112



113

소모품 교체

헤드 캡 교체
헤드 캡이 아래 그림과 같이 마모되면 교체 시기입니다. 필요에 따라 헤드 캡을 새 것으로 교체하십
시오.
마모 정도는 각인 상태에 따라 달라질 수 있습니다.  특히 알루미늄과 같은 소재에  island fill* 및 
기타 contour 작업을 광범위하게 사용하는 각인은 소재 표면의 광범위한 요철로 인해 빠른 마모를 
유발합니다.  헤드 캡의 상태를 주기적으로 확인하여 필요할 때마다 교체하도록 합니다.

* Island Fill : 간격을 두고 배치된 선을 사용하여 문자 및 개체(Fill 개체 제외)를 각인합니다.
자세한 내용은 METAZAStudio 도움말("Commands" - "[Format] menu" - "Font" -
"[Properties] 대화 상자")을 참조하십시오.
 P.60 "소재 장착"

교체가 필요한 헤드 캡

탭

마모

탭

헤드 교체
다음과 같은 경우 헤드를 교체해야 합니다.

• 헤드의 수명이 다했습니다.
• 마킹 핀이 마모되었습니다.

헤드 수명 가이드

다음 조건에서 약 4,000개의 개체를 인쇄할 수 있습니다.

사용 소재 MD-NI(Roland nickel-plated plate)
각인 영역 30mm(W) × 23mm(D)(1.2in. × 0.9in.)
각인 모드 Photo
각인 면적 각인 영역의 35%(25,000 dots per plate)

METAZAStudio에도 헤드 수명을 나타내는 메시지가 나타납니다.
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소 모 품  교 체

[OK]를 클릭하면 메시지가 사라집니다.  [Details]를 클릭하면 MPX-95 Head Manager가 나타납니다.
 P.114 "마킹 핀 상태 확인 방법"

마킹 핀 상태 확인 방법

MPX-95 Head Manager를 이용하여 마킹핀의 상태를 확인할 수 있습니다.

절차

A MPX-95 Head Manager를 시작합니다.
 P.28 "소프트웨어 시작 방법"

B 기기의 전원을 켭니다.
 P.32 "전원 켜기"

핀 사용량이 이 창에 표시됩니다.  핀이 소재를 치
는데 사용됨에 따라 레벨 표시기가 조금씩 증가합
니다.  증가율은 각인되는 소재에 따라 다릅니다.

화면의 refresh를 클릭하여 최신 정보를 표시합니
다.
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소 모 품  교 체

MEMO

MPX-95 Head Manager의 [The amount of Pin usage] 표시기는 마킹핀의 사용량을 보
여줍니다.  다음과 같은 경우 헤드를 교체해야 합니다.

• 표시기가 빨간색으로 표시됩니다.
• 표시등이 빨간색으로 표시되지는 않지만 고퀄리티의 각인이 불가능하거나 이미지가 고르지
않습니다.

마모된 마킹 핀이 인쇄 품질 저하 및 불균일한 인쇄 결과의 유일한 원인은 아닙니다.  문제
의 원인을 찾으려면 다음 페이지를 참조하십시오.  마킹 핀의 마모가 문제의 원인일 수 있
는 경우 헤드를 새 것으로 교체하십시오.

 P.121 "각인된 이미지의 품질이 좋지 않은 경우" 
 P.122 "이미지가 고르지 않은 경우"

헤드 교체 방법

헤드 교체에는 MPX-95 Head Manager를 사용합니다. 그림에 표시된 패턴은 헤드 교체 작업 중에 
각인 합니다.  교체용 헤드(MPH-90)와 함께 제공되는 테스트 각인 소재(황동) 또는 너비 
60mm(2.4in) x 길이 60mm(2.4in) 이상의 소재를 준비해야 합니다.

* 교체용 헤드는 별매품입니다.  구매 정보는 공인 Roland DG Corporation 대리점에 문의하거나
당사 웹사이트(http://www.rolanddg.kr/)를 방문하십시오.

조정 패턴

IMPORTANT

• 교체 작업을 중간에 중단하지 마십시오.
• 마킹 핀이 마모된 경우 헤드를 사용하지 마십시오.
• 기기에서 분리된 헤드를 사용하지 마십시오.

절차

A MPX-95 Head Manager를 시작합니다.
 P.28 "소프트웨어 시작 방법"

B 기기의 전원을 켭니다.
 P.32 "전원 켜기"
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소 모 품  교 체

C [Replace Head]를 클릭합니다.
화면의 지시에 따라 핀 조정을 수행하십시오.

• 접착 시트와 그리드 테이블을 사용하여 테스트 패턴으로 각인할 소재를 설정합니다.
 P.60 "소재 장착"

• 헤드 캡 사용

• 조정 패턴이 인쇄되지 않으면 아래에 제공된 섹션을 참조하십시오.
 P.120 "각인된 위치가 원하는 위치가 아닌 경우"

D 완료되면          을 클릭합니다. 
창이 닫힙니다.
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문제 해결

[전원/이동] 버튼이 깜박이는 경우

헤드 높이가 고정된 상태에서 
전원을 켰습니까?

헤드의 높이가 고정된 상태에서 전원을 켜면 초기 동작이 
멈춥니다.  소재가 장착된 상태에서 기기가 초기 작동을 계
속하면 소재 표면이 긁히거나 마킹 핀이 손상될 수 있습니
다.  노브를 시계 반대 방향으로 한 번 풀고 헤드의 스토퍼
를 링에 대고 누르면서 노브를 조입니다.  [전원/이동] 버튼
을 눌러 초기 동작을 완료하면 램프가 깜박임을 멈추고 점
등됩니다.

링
스토퍼

잠금잠금풀림

노브의 중심은 삼각형 표시의 상단 바로 위에 
위치해야 합니다.

헤드 캡을 사용하지 않는 경우 
헤드 위치 높이 조절을 수행 했
나요?

헤드의 끝이 소재의 표면에 닿습니다.  [Power/
Movement] 버튼을 1초 이상 눌러 전원을 끕니다.  헤드 
캡을 사용하지 않고 각인할 경우 소재의 표면 높이에 따라 
헤드 위치를 적절한 위치로 조정하고 노브로 헤드를 단단
히 고정합니다.  헤드가 소재의 표면 높이보다 낮은 위치에 
고정되면 헤드의 끝이 소재의 표면에 부딪힙니다.

P. 60 "소재 장착"

전원을 켤 때 헤드가 올라가나
요?

헤드가 맨 위로 올라가기 때문에 기기는 소재의 표면 높이
가 각인을 수행하기 위한 요구 사항을 충족하지 않는지 확
인합니다.  [전원/이동] 버튼을 1초 이상 눌러 전원을 끕니
다.  전원을 켤 때 불필요하게 헤드를 만지지 않도록 주의
하십시오.

각인 표면의 높이 편차가 너무 
큰가요?

[전원/이동] 버튼을 1초 이상 눌러 전원을 끕니다.  각인 가
능한 소재의 상태를 확인하고 소재를 다시 선택하십시오.

P. 42 "소재 준비"

소재가 소재 두께(높이)에 맞게 
설정되었습니까?

[전원/이동] 버튼을 1초 이상 눌러 전원을 끕니다.
각인 가능한 높이와 소재 표면의 높이가 맞지 않습니다. 소
재의 두께(높이)에 따라 설정 방법이 다르기 때문에 소재를 
높이에 맞게 재장착 합니다.

P. 60 "소재 장착"

4

문
제

 해
결

풀림



문 제  해 결

노브가 풀렸습니까?

[전원/이동] 버튼을 1초 이상 눌러 전원을 끕니다.
헤드 캡을 사용하지 않은 상태에서 각인 중 노브가 느슨해
지면 헤드 위치가 소재의 표면 높이와 일치하지 않습니다.  
헤드 위치를 설정할 때 손잡이를 단단히 조이십시오.

P. 60 "소재 장착"

각인 데이터를 출력해도 기기가 작동하지 않는 경우

전원이 켜져 있습니까?

전원/이동 버튼 표시등이 켜져 있는지 확인합니다.  점등되
어있지 않으면 전원/이동 버튼을 눌러 전원을 켭니다.

P. 32 "전원 켜기"

전원 코드가 올바르게 연결되
어 있습니까?

올바르게 연결되지 않은 경우 올바르게 연결하십시오.

P. 31 "기기를 컴퓨터에 연결"

컴퓨터 연결에 사용된 케이블이 
올바르게 연결되어 있습니까?

연결 케이블이 분리되어 있는지 확인하십시오.

METAZAStudio를 사용하여 각인할 오브젝트의 소재를 선택할 수 없는 경우

[Use printer driver settings] 
확인란이 선택되어 있습니까?

METAZAStudio가 시작된 직후에 표시되는 [Select 
Material] 대화 상자에서 [Use printer driver settings] 
확인란을 선택하면 소재를 선택할 수 없습니다.  [Use 
printer driver settings] 확인란의 선택을 취소합니다.

METAZAStudio의 이전 버전
에서 생성된 파일을 사용하고 
있습니까?

2.00 이전 버전의 METAZAStudio에서 생성된 파일을 사용하
여 소재를 선택할 수 없습니다.  2.00 이상 버전의 
METAZAStudio를 사용하여 파일을 저장하고 소재를 선택합니
다.
METAZAStudio의 [Help] 메뉴→[About]을 클릭하면 표시되는 
창에서 METAZAStudio의 버전을 확인할 수 있습니다.
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각인된 위치가 원하는 위치가 아닌 경우

소재가 올바른 위치에 장착되어 
있습니까?

베이스 유닛이 올바르게 설치되었는지 확인하십시오. 또한 
레이저 포인터가 각인할 소재의 중심을 가리키는지 확인하
고 필요에 따라 위치를 조정합니다.

P. 60 "소재 장착"

타격이 수행되지만 아무 것도 
각인되지 않습니다.

소재가 이 기기로 각인하기 위한 요구 사항을 충족합니까?
각인 가능한 소재를 준비하고 사용합니다.

P. 42 "소재 준비"

헤드 캡을 사용하지 않는 경우 
헤드 위치가 소재의 표면 높이
와 일치합니까?

헤드 캡을 사용하지 않는 경우 헤드 위치가 소재의 표면 높
이와 일치하는지 확인하십시오.  헤드 위치가 소재의 높이 
위치와 일치하지 않으면 각인을 수행할 수 없습니다.  헤드 
위치를 조정한 다음 노브를 단단히 조입니다.

P. 60 "소재 장착"

기기의 원점이 어긋나 있습니
까?

원점이 어긋나면 원하는 위치에 텍스트와 이미지가 인쇄되
지 않습니다.  MPX-95 Head Manager를 사용하여 원점
을 조정합니다.

P. 111 "원점 위치 조정"

마킹 핀이 휘거나 부러졌습니
까?

아무 것도 인쇄되지 않고 소재가 장착되는 위치를 변경하
거나 소재에 대한 파라미터 또는 헤드 유닛의 높이 문제를 
수정하지 않으면 마킹 핀이 구부러지거나 부러질 수 있습
니다.  새 마킹핀으로 교체하여 테스트 임프린팅을 해보세
요.  새 마킹 핀으로 각인이 가능하다면 사용하던 마킹 핀
이 휘거나 부러진 것입니다.  새 마킹 핀을 계속 사용하십
시오.

구부러지거나 
부러지지 않음

구부러지거나 
부러짐

P. 113 "헤드 교체"
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각인된 이미지의 품질이 좋지 않은 경우

소재 설정이 올바릅니까?

METAZAStudio에서 장착된 소재의 구성을 선택하십시오.  
소재의 재질이 같더라도 주조 방법, 불순물의 조성, 도금 
여부 등에 따라 각인 표면의 경도가 크게 달라질 수 있습
니다.  이러한 경우 타격력의 미세 조정이 필요합니다.

P. 102 "구성 등록 및 타격력 조정"

P. 51 "Step 1: 소재의 모양과 크기 결정"의 Step B 참조.

인쇄된 이미지가 흐릿합니까?

이미지가 선명하게 인쇄되지 않으면 이미지의 밝기를 조정
하십시오.
드라이버 설정 창에서 [Gamma] 또는 [Brightness]의 밝
기를 조금씩 높이면서 각인을 수행하십시오.  이때, 소재를 
장착한 상태로 동일한 위치에서 오버스트라이크를 수행합
니다.  설정을 변경하는 동안 원하는 조건을 얻을 때까지 
각인을 계속하십시오.

P. 88 "이미지의 완성된 결과 확인 및 조정"

그레이스케일 톤이 선명하게 
각인됩니까?

그레이스케일 톤이 불명확한 경우 METAZA Driver 2의 설
정 창([Image Correction] 탭의 [Details])으로 이동하여 
타각력을 조정하십시오.  [Impact--MAX] 값을 변경하지 
않고 [Impact--MIN] 값을 한 번에 조금씩 증가시키면서 
Imprinting을 수행합니다.  이때, 소재를 장착한 상태로 동
일한 위치에서 오버스트라이크를 수행합니다. METAZA 
Driver 2 설정 창에서 설정을 계속 변경하고 원하는 농도가 
될 때까지 각인을 수행합니다.

오버스트라이크 및 최종 설정 값으로 인한 각인 결과에 

대해

오버스트라이킹은 한 번에 조금씩 설정을 변경하면
서 같은 위치를 반복적으로 치면 원하는 각인 결과를 
얻을 수 있는 방법입니다.  따라서 오버스트라이크를 
할 때 적용된 최종 설정값을 이용하여 새로운 소재에 
한번만 각인을 해도 오버스트라이크를 할 때와 같은 
각인 결과를 얻을 수는 없습니다.

P. 102 "구성 등록 및 타격력 조정"

마킹 핀이 마모되었습니까?

마킹핀이 마모되면 고품질 각인이 불가능할 수 있습니다.  
마킹 핀의 상태를 확인하십시오.  마킹 핀이 마모된 경우 
헤드를 새 것으로 교체하십시오.

P. 113 "헤드 교체"

헤드 캡을 장착했습니까?

헤드 캡이 마모되면 고품질 각인이 불가능할 수 있습니다.  
헤드 캡의 상태를 확인하십시오.  헤드 캡이 마모된 경우 
헤드 캡을 새 것으로 교체하십시오.

P. 113 "헤드 캡 교체"
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이미지가 고르지 않은 경우

인쇄물 표면이 고르지 않습니
까? / 각인 표면이 비스듬한가
요?

헤드 캡을 장착하고 각인을 수행합니다.  헤드 캡이 장착된 
상태에서 각인에 의해 손상될 수 있는 소재를 사용하는 경
우 각인 표면이 평평한 소재로 교체하십시오.

P. 61 "헤드캡 사용시 주의사항"

이미지의 어두운 부분이 고르지 
않습니까?

오버스트라이크를 수행하면 이미지 품질이 향상될 수 있습
니다.  소재를 장착한 상태에서 미리보기 창에서 
[Gamma], [Brightness] 또는 [Contrast]를 조정하여 오
버스트라이크를 수행해 보십시오.

P. 88 "이미지의 완성된 결과 확인 및 조정"

양방향 각인이 수행되었습니
까?

양방향 각인은 각인 시간을 단축할 수 있지만 이미지 품질
이 떨어질 수 있습니다.  이 경우 METAZA Driver 2 설정 
창으로 이동하여 [Bidirection]의 선택을 취소한 다음 각인
을 다시 수행하십시오.

METAZA Driver 2 온라인 도움말 ("[Material] tab")

마킹 핀이 마모되었습니까?

마킹핀이 마모되면 고품질 각인이 불가능할 수 있습니다.  
마킹 핀의 상태를 확인하십시오.  마킹 핀이 마모된 경우 
헤드를 새 것으로 교체하십시오.

P. 113 "헤드 교체"

헤드 캡을 착용했습니까?

헤드 캡이 마모되면 매력적인 각인이 불가능할 수 있습니
다.  헤드 캡의 상태를 확인하십시오.  헤드 캡이 마모된 경
우 헤드 캡을 새 것으로 교체하십시오.

P. 113 "헤드캡 교체"
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이미지가 항상 같은 위치가 희미하게 각인 되는 경우

각인 표면의 높이 편차가 너무 
높습니까?

헤드 캡을 이용하여 각인을 하여도 항상 같은 위치에서 이
미지가 흐릿하다면, 각인 표면의 높이 편차가 과도할 수 있
습니다.  기기에서 각인할 수 있는 소재에 대한 요구 사항
을 다시 확인하고 요구 사항에 맞는 소재를 선택하십시오.  
또한 이 기기로 곡면에 사진 데이터를 인쇄할 때 이미지 품
질이 보장되지 않습니다.

P. 42 "소재 준비"

기기가 약간 기울어질 수 있습
니다.

그리드 테이블의 전면 오른쪽 영역과 같은 동일한 위치에서 
이미지가 종종 희미하면 기기가 약간 기울어져 있을 수 있습
니다.  기기의 수평을 조정하면 이미지 품질이 향상될 수 있습
니다.  다음 절차에 따라 기기의 수평을 조정하십시오.
이미지의 요철이 각인 위치와 관련이 없는 경우(예: 소재 또는 
이미지마다 요철 영역이 다른 경우) 이 방법은 효과적이지 않
습니다.  가능하면 헤드 캡을 사용하는 것이 좋습니다.
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기기 각도 조정

절차

A 제공된 테스트 소재를 그리드 테이블에 장착합니다.

• 접착 시트를 사용하여 그리드 테이블의 중앙에 놓습니다.
• 제공된 소재를 모두 사용한 경우 60mm(2.4in)보다 크고 평활도가 0.05mm(0.002in)
이하인 소재 조각을 준비합니다.
• 헤드 캡을 사용하지 않고 각인을 수행합니다.
 P. 60 "소재 장착"

B 프린터 아이콘을 표시합니다.

Windows 10
① 컴퓨터에서 [시작] 메뉴를 클릭합니다.
② [Windows 시스템]을 클릭한 후 [제어판]을 클릭합니다.
③ [장치 및 프린터 보기]를 클릭합니다.

Windows 8.1
① 컴퓨터에서 [시작] 메뉴를 마우스 오른쪽 버튼으로 클릭합니다.
② [제어판]을 클릭합니다.
③ [장치 및 프린터]를 클릭합니다.

C "Roland MPX-95" 아이콘을 마우스 오른쪽 버튼으로 클릭하고 [인쇄 기본 설정]을 클릭
       합니다.

METAZA 드라이버 2의 인쇄 기본 설정 화면이 열립니다.
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D [Option] 탭에서 [Test Print]를 클릭합니다.

테스트 패턴이 소재에 각인됩니다.

E 스케일을 사용하여 테스트 패턴이 연속적이지 않거나 보이지 않는 위치를 읽고 기록합니다.

네 방향(앞, 뒤, 왼쪽, 오른쪽) 모두의 값을 확인합니다.

Right

Front

Back

Left

4

문
제

 해
결

125



문 제  해 결

F 보정값을 입력합니다.
① [Correct slope]를 선택합니다.

② METAZA Driver 2에 E 에서 적어둔 스케일 값을 입력합니다.

③ [OK]을 클릭합니다.
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드라이버를 별도로 설치
METAZA Driver 2와 소프트웨어를 동시에 설치할 수 있습니다.  동시에 설치하려면 P.24 "드라이버 및

소프트웨어 설치"를 참조하십시오.

절차

A 관리자 또는 관리자 그룹의 구성원으로 Windows에 로그온합니다. 

B DGSHAPE 소프트웨어 패키지 CD를 컴퓨터에 넣습니다.

자동 재생 창이 나타나면 [메뉴 실행]을 클릭합니다.  설정 메뉴가 자동으로 나타납니다.

C METAZA Driver 2가 이미 설치된 경우 제거하십시오.
 P. 132 "드라이버 제거"

드라이버가 설치되지 않았거나 제거된 경우 Step D 로 이동합니다. 

D [Custom Install]를 클릭합니다.

E METAZA Driver 2의 [Install]을 클릭합니다.
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F [Install]를 선택하고 모델명은 [MPX-95]를 선택, 포트는 [USB]를 선택한 후 [Start]을 클릭
      합니다.

METAZA Driver 2 설치가 시작됩니다.  화면의 지시에 따라 진행하십시오.  설치 중에 아래와 
같은 화면이 나타나면 다음 작업을 수행하십시오.
Windows 10

[Install]을 클릭합니다.
Windows 8.1

[Install]을 클릭합니다.

G 여기에 표시된 화면이 표시되면 [Finish]를 클릭합니다.
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H 설정 메뉴의          를 클릭합니다.

I CD-ROM 드라이브에서 CD를 꺼냅니다.

J USB 케이블을 사용하여 기기를 컴퓨터에 연결합니다.

포함된 USB 케이블을 사용하십시오.  USB 허브를 사용하지 마십시오.

METAZA Driver 2가 자동으로 설치됩니다.
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소프트웨어를 별도로 설치

절차

A 관리자 또는 관리자 그룹의 구성원으로 Windows에 로그온합니다. 

B DGSHAPE 소프트웨어 패키지 CD를 컴퓨터에 넣습니다.

자동 재생 창이 나타나면 [메뉴 실행]을 클릭합니다.  설정 메뉴가 자동으로 나타납니다.

C [Custom Install]을 클릭합니다.

D 설치하려는 프로그램의 [Install]를 클릭합니다.
 P. 23 "설치 및 설정할 수 있는 소프트웨어"

METAZA 드라이버 2 설치에 대한 정보는 P.127 "드라이버를 별도로 설치"를 참조하십시오.

E 메시지에 따라 소프트웨어를 설치하십시오.
[사용자 계정 컨트롤]이 나타나면 [허용]을 클릭하여 소프트웨어를 설치합니다.

F 설치가 완료되면 설정 메뉴의          를 클릭합니다.
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드라이버 설치가 불가능한 경우
설치가 도중에 종료되거나 USB 케이블로 연결할 때 마법사가 나타나지 않으면 METAZA Driver 2의 
설치가 불가능할 수 있습니다.  이러한 경우 다음 절차를 수행하십시오.(절차 A로 문제가 해결되지 
않으면 절차 B를 수행하십시오.)

절차 A

A 케이블을 사용하여 기기를 컴퓨터에 연결하고 기기의 전원을 켭니다.

B [Desktop]를 클릭합니다.

C 아래 표시된 절차에 따라 [장치 및 프린터 보기](또는 [장치 및 프린터])를 클릭합니다.

Windows 10
① 컴퓨터에서 [시작] 메뉴를 클릭합니다.
② [Windows 시스템]을 클릭한 후 [제어판]을 클릭합니다.
③ [장치 및 프린터 보기]를 클릭합니다.

Windows 8.1
① 컴퓨터에서 [시작] 메뉴를 마우스 오른쪽 버튼으로 클릭한 후 [제어판]을 클릭합니다.
② [장치 및 프린터]를 클릭합니다.

D 사용 중인 모델이 "미지정"에 표시되는지 확인합니다.

E 사용 중인 모델의 아이콘을 마우스 오른쪽 버튼으로 클릭한 후 [장치 제거]를 클릭합니다.

F "이 장치를 제거하시겠습니까?"라는 메시지가 표시되면 가 표시되면 [예]를 클릭합니다. 

G 사용 중인 모델의 아이콘이 "미지정" 아래에 더 이상 표시되지 않는지 확인합니다.

H USB 케이블을 일시적으로 분리했다가 다시 연결합니다.  사용 중인 기기의 프린터 
     아이콘이 "프린터" 아래에 표시되면 Windows 드라이버가 성공적으로 설치된 것입니다.

이렇게 해도 문제가 해결되지 않으면 "절차 B"의 절차를 수행하십시오.

절차 B

A USB 케이블을 사용하여 기기를 컴퓨터에 연결하고 기기의 전원을 켭니다.

B [새 하드웨어 발견]이 나타나면 [취소]를 클릭하여 닫습니다.  이 기기 이외의 프린터용

     USB 케이블을 모두 분리합니다.

C [데스크톱]을 클릭합니다.

D [시작] 버튼을 마우스 오른쪽 버튼으로 클릭하고 [장치 관리자]를 클릭합니다.
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E [사용자 계정 컨트롤] 창이 나타나면 [계속]을 클릭합니다.  [장치 관리자]가 나타납니다.

F [보기] 메뉴에서 [숨겨진 장치 표시]를 클릭합니다.

G 목록에서 [프린터] 또는 [기타 장치]를 찾아 더블 클릭합니다.  선택한 항목 아래에 나타나는

      모델 이름 또는 [알 수 없는 장치]를 클릭합니다.

H [동작] 메뉴에서 [제거] 또는 [장치 제거]를 클릭합니다.

I "장치 제거 확인" 창에서 [확인]을 클릭합니다.  또는 "장치 제거" 창에서 [제거]를 클릭

    합니다.  [장치 관리자]를 닫습니다.

J 컴퓨터에서 USB 케이블을 분리한 다음 Windows를 다시 시작합니다.

K Windows 드라이버를 제거합니다.  드라이버를 제거하려면 P.132 "드라이버 제거"의 3단계부터

     수행하십시오.

L 설치 가이드"("소프트웨어 설치") 또는 P.127 "드라이버를 별도로 설치"의 절차에 따라 드라이버를

      다시 설치하십시오.

드라이버 제거
METAZA Driver 2를 제거할 때 다음 작업을 수행하십시오.

절차

*아래의 절차를 따르지 않고 드라이버를 제거하면 재설치가 불가능할 수 있습니다.

A 기기의 전원을 끄고 기기와 컴퓨터를 연결한 커넥터 케이블(USB)을 분리합니다.

B Windows에 관리자로 로그온합니다.

C [Desktop]을 클릭합니다.

D 아래 표시된 절차에 따라 [제어판]을 클릭합니다.

Windows 10
① 컴퓨터에서 [시작] 메뉴를 클릭합니다.
② [Windows 시스템]을 클릭하고 [제어판]을 클릭합니다.

Windows 8.1
① 컴퓨터에서 [시작] 메뉴를 마우스 오른쪽 버튼으로 클릭하고 [제어판]을 클릭합니다.

E [프로그램 제거] 또는 [프로그램 및 기능]을 클릭합니다.

F 삭제할 기기의 Windows 드라이버를 클릭하여 선택하고 [제거]를 클릭합니다.  [사용자 계정

       컨트롤]이 나타나면 [허용] 또는 [예]를 클릭합니다.
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G 삭제를 확인하는 메시지가 나타나면 [예]를 클릭합니다.

H [시작]을 마우스 오른쪽 버튼으로 클릭하고 [데스크톱]을 클릭합니다.

I 탐색기를 열고 Windows 드라이버가 포함된 드라이브와 폴더를 엽니다.(*) 

J "SETUP64.EXE"(64비트 버전) 또는 "SETUP.EXE"(32비트 버전)를 더블 클릭합니다.

K [사용자 계정 컨트롤] 창이 나타나면 [허용]을 클릭합니다.  Windows 드라이버 설치 프로그램이

       시작됩니다.

L [제거]를 클릭합니다.  제거할 기기를 선택하고 [시작]을 클릭합니다.

M 컴퓨터를 다시 시작해야 하는 경우 다시 시작하라는 창이 나타납니다.  [예]를 클릭합니다.

N  컴퓨터가 다시 시작되면 제어판을 다시 열고 [장치 및 프린터 보기] 또는 [장치 및 프린터]를

      클릭합니다.

O  제거할 기기의 아이콘이 보이면 마우스 오른쪽 버튼을 클릭하고 [장치 제거]를 클릭합니다.

(*)
CD-ROM을 사용하는 경우 아래와 같이 폴더를 지정하십시오. (이것은 CD-ROM 드라이브가 D 
드라이브라고 가정합니다.)
D: \Drivers\X64(64비트 버전)
D: \Drivers\X86(32비트 버전)
DGSHAPE 소프트웨어 패키지 CD를 사용하지 않는 경우 DGSHAPE Corporation 웹 사이트
(http://www.rolanddg.kr/)로 이동하여 제거하려는 시스템의 Windows 드라이버를 다운로드하고 
원하는 폴더를 지정합니다.  다운로드한 파일의 압축을 해제합니다.
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134

기기의 이동

IMPORTANT

기기를 이동할 때 아래에 설명된 제거/부착 절차를 수행하십시오.  그렇게 하지 않고 기기를 이동하면 
기기가 손상될 수 있습니다.

1. 기기에 부착된 제공된 모든 항목을 제거합니다.

A 전원이 꺼져 있는지 확인하십시오. 

B 기기의 커버를 엽니다.

C 베이스 유닛이 제거된 경우 설치하십시오.
 P. 37 "베이스 플레이트 설치/제거"

D 베이스 유닛에 그리드 테이블이 장착되어 있는 경우 제거하십시오.

그리드 테이블 외에도 옵션 키트 소재 리테이너가 장착된 경우 제거하십시오.

그리드 테이블 
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기 기 의  이 동

2. 헤드 캡을 헤드에 장착합니다.

헤드 캡 
헤드

헤드를 고정

3. 리테이너를 장착합니다.

A 전원/이동 버튼을 10초 이상 누르고 있습니다.
헤드는 아래와 같이 움직입니다.

B 헤드를 가장 높은 위치에 고정합니다.
① 노브를 풉니다.
② 헤드를 가장 높은 위치로 들어올리고 노브를 조입니다.

잠김

헤드

열림

헤드를 들어 올립
니다.

노브의 중심은 삼각형 표
시의 상단 바로 위에 위치
해야 합니다.
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C 전원 코드와 USB 케이블을 제거합니다. 

D 리테이너를 장착합니다.

기기는 5개 지점(아래 ①에서 ⑤까지)에서 리테이너와 나사로 고정됩니다.  모든 리테이너
를 장착하고 제공된 육각 렌치로 나사를 조입니다.  리테이너 A, 리테이너 B 및 고정 나사
를 보관할 위치에 대한 정보는 P.30 "리테이너 제거"를 참조하십시오.

사용 품목 리테이너

육각렌치 리테이너 A(2) 리테이너 B(L, R 각각 1개) 리테이닝 스크류 (7)

리테이너 B

기기의 왼쪽과 
오른쪽에 고정
합니다.

리테이너 A

리테이너 A

E 커버를 닫고 기기를 다시 포장하십시오.

기기를 이동할 때는 반드시 두 손으로 바닥을 받쳐 주십시오.  다른 위치를 잡고 기기를 이
동하려고 하면 손상될 수 있습니다.
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각인 영역

최대 각인 영역 및 권장 각인 영역

70mm(2.8in.)

기기 측면

(기기와의 거리)

80mm 
(3.2in.)

118mm(4.6in.)

중심라인

중심라인

그리드 테이블의 평면도

권장 각인 영역
(50mm × 50mm(2.0in. × 2.0in.))

80mm(3.2in.)

50mm(2.0in.)

50mm
(2.0in.)

80mm
(3.2in.) 

최대 각인 영역(80mm × 80mm(3.2in × 3.2in))
METAZA Driver 2를 통한 설정 구성이 필요합니다.  이미지가 인쇄 가능 영역을 
초과하면 인쇄 결과가 인쇄 가능 영역 외부에서 고르지 않을 수 있습니다.

본체 사양

5
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본 체  사 양

정격 전력 및 일련 번호 라벨의 위치

전력 등급
전압, 주파수 및 암페어 요구 사항을 충
족하는 전기 콘센트를 사용하십시오.

뒷면

일련번호
유지 보수, 서비스 또는 지원을 요청할 때 
필요합니다.  라벨을 벗기거나 더러워지
지 않도록 하십시오.

전력 등급
전압, 주파수 및 암페어 요구 사항을 충족
하는 전기 콘센트를 사용하십시오.

AC 어댑터
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사양

MPX-95

각인 가능한 소재 금, 은, 동, 백금, 황동, 알루미늄, 철, 스테인리스 등
(각인면의 비커스경도[HV]는 200이하이어야 함.)

장착 가능한 소재 크기 베이스 테이블 + 베이스 플레이트 사용시 :
최대.100mm(W)×200mm(L)×40mm(H)(3.9in.×7.9in.×1.6in.) 
또는 200mm(W)×100mm(L)×40mm(H)(7.9in.×3.9in.×1.6in.)

베이스 플레이트만 사용시 :
최대.100mm(W)×200mm(L)×70mm(H)(3.9in.×7.9in.×2.8in.) 
또는 200mm(W)×100mm(L)×70mm(H)(7.9in.×3.9in.×2.8in.)

*위의 수치는 커버를 닫았을 때입니다.  커버를 열었을 때 소재의 크기에
는 제한이 없지만 소재의 각인 영역은 각인 영역 내에 위치해야 합니다.

 P.139 "각인 영역"

각인 영역 최대 각인 가능 
영역

80mm(W)×80mm(D)×70mm(H)
(3.2in.×3.2in.×2.8in.)

권장 각인 영역 50mm(W)×50mm(D)×70mm(H)
(2.0in.×2.0in.×2.8in)

해상도 529dpi(High resolution), 353dpi(Photo), 265dpi(Text), 1058dpi(Vector)

각인 방향 단방향 각인 또는 양방향 각인
(Windows 드라이버로 선택 가능)

각인 속도 (기본설정) 50mm/sec(2.0 in./sec)(Photo), 33mm/sec(1.2 in./sec)(High 
resolution/Text), 24mm/sec(0.94 in./sec)(Vector)

인터페이스 USB

전원 요구 사항 전용 AC 어댑터 AC100~240V ±10%, 50/60Hz

본체 DC19 V, 1.2A

전력 소모량 약. 21W

작동 소음 70dB(A) 이하

작동 온도 10~30℃(50~86℉)

작동 습도 35~80%(결로 없을 것)

외부 치수 286mm(W)x383mm(D)x308mm(H)(11.3in.(W)x15.1in.(D)x12.2in.(H))

줄양 12kg(26.5lb.)

번들된 품목 AC 어댑터, 전원 코드, 테스트용 소재, USB 케이블, DGSHAPE 소프트웨어 
패키지 CD, 사용 설명서 등
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